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1  Welcome to the ATSC 3.0 Option
The R&S SMCVB-K162 is a firmware application that adds functionality to generate
signals in accordance with the ATSC 3.0 digital standard.

The R&S SMCVB-K162 option features:

● ATSC 3.0 signal generation

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMCV100B service manual.

1.1  Accessing the ATSC 3.0 Dialog

To open the dialog with ATSC 3.0 settings

► In the block diagram of the R&S SMCV100B, select "Baseband > ATSC 3.0".

A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

1.2  Documentation Overview

This section provides an overview of the R&S SMCV100B user documentation. Unless
specified otherwise, you find the documents on the R&S SMCV100B product page at:

www.rohde-schwarz.com/manual/smcv100b

1.2.1  Getting Started Manual

Introduces the R&S SMCV100B and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.2.2  User Manuals and Help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Documentation Overview

http://www.rohde-schwarz.com/manual/smcv100b


Welcome to the ATSC 3.0 OptionR&S®SMCVB-K162

8User Manual 1179.0980.02 ─ 03

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMCV100B is not included.

The contents of the user manuals are available as help in the R&S SMCV100B. The
help offers quick, context-sensitive access to the complete information for the base unit
and the software options.

All user manuals are also available for download or for immediate display on the Inter-
net.

1.2.3  Service Manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.2.4  Instrument Security Procedures

Deals with security issues when working with the R&S SMCV100B in secure areas. It
is available for download on the Internet.

1.2.5  Printed Safety Instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.2.6  Data Sheets and Brochures

The data sheet contains the technical specifications of the R&S SMCV100B. It also
lists the options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smcv100b

Documentation Overview

https://gloris.rohde-schwarz.com
http://www.rohde-schwarz.com/brochure-datasheet/smcv100b
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1.2.7  Release Notes and Open Source Acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The open-source acknowledgment document provides verbatim license texts of the
used open source software.

See www.rohde-schwarz.com/firmware/smcv100b

1.2.8  Application Notes, Application Cards, White Papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/smcv100b

1.3  Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:
● Managing settings and data lists, like saving and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMCV100B user manual.

1.4  Notes on Screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on Screenshots

http://www.rohde-schwarz.com/firmware/smcv100b
http://www.rohde-schwarz.com/application/smcv100b
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2  About the ATSC 3.0 Option
The transmission standard complies with the ATSC A/322 specification. A subset of all
possible parameters found in the specification can be set on the R&S SMCV100B.

2.1  Required Options

The equipment layout for generating ATSC 3.0 signals includes:
● Base unit
● Option Enable Broadcast Standards (R&S SMCVB-K519)
● Option ATSC 3.0 (R&S SMCVB-K162)

Required Options
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3  ATSC 3.0 Configuration and Settings
Access:

► Select "Baseband > ATSC 3.0".

The remote commands required to define these settings are described in Chapter 4,
"Remote-Control Commands", on page 67.

Settings:

● General Settings......................................................................................................11
● Input Signal Settings............................................................................................... 14
● Encaps Settings...................................................................................................... 22
● BICM Settings......................................................................................................... 24
● OFDM Settings........................................................................................................30
● System Settings...................................................................................................... 37
● Frame Info...............................................................................................................45
● SFN Settings...........................................................................................................50
● Special Settings...................................................................................................... 54
● Data Generation Settings........................................................................................56
● Global Connector Settings...................................................................................... 57
● TS Player................................................................................................................ 57

3.1  General Settings

Access:

► Select "Baseband > ATSC 3.0".

The "ATSC 3.0" tab provides functionality for calling default settings, save and
recall settings and settings necessary to configure the STL interface and IP set-
tings.

General Settings
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Settings:

State..............................................................................................................................12
Set To Default................................................................................................................12
Save/Recall................................................................................................................... 12
STL Interface.................................................................................................................12
Destination IP Address..................................................................................................13
Destination IP Port........................................................................................................ 13
Data Generation............................................................................................................13
Test Cases.................................................................................................................... 13

└ Filter Test Cases............................................................................................. 13
Reset Log File............................................................................................................... 13
Status Info..................................................................................................................... 14

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:STATe on page 68

Set To Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

State Not affected by the "Set to Default"

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PRESet on page 68

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.

The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.

See also, chapter "File and Data Management" in the R&S SMCV100B user manual.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SETTing:CATalog on page 69
[:SOURce<hw>]:BB:A3TSc:SETTing:DELete on page 69
[:SOURce<hw>]:BB:A3TSc:SETTing:LOAD on page 69
[:SOURce<hw>]:BB:A3TSc:SETTing:STORe on page 69

STL Interface
Activates the STL interface.

"On" Uses the incoming STL stream to configure the modulator for single
or multiple PLP transmissions (single or multiple subframes).

General Settings
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"Off" Uses the incoming MPEG transport stream, ROUTE/DASH or MMT
stream directly as payload for single PLP transmission (single sub-
frame).

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:STL:INTerface on page 73

Destination IP Address
Sets the destination IP address of the IP connection for external or internal IP data.

Only multicast IPv4 streaming is supported. Therefore, the address range is restricted
to the IPv4 multicast address range, that is 224.0.0.0 to 239.255.255.255.

Note: You can use only IP addresses that are not occupied by the Linux OS or applica-
tions, drivers and services running on the R&S SMCV100B.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:DESTination:IP:ADDRess on page 72

Destination IP Port
Sets the destination IP port of the IP connection for external or internal IP data.

The range is restricted to port numbers 0 to 65535.

Note: You can use only IP ports that are not occupied by the Linux OS or applications,
drivers and services running on the R&S SMCV100B.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:DESTination:IP:PORT on page 72

Data Generation
Accesses the "3.0 Data Generation" tab.

See Chapter 3.10, "Data Generation Settings", on page 56.

Test Cases
Accesses a standard file-select dialog to select ATSC 3.0 test cases.

For available test cases, see Chapter A, "ATSC 3.0 Test Cases", on page 126.

Filter Test Cases ← Test Cases
Filters the test case selection.

Reset Log File
Requires "STL Interface > On".

Resets the log file.

Status information of the ATSC 3.0 coder as displayed in "Status Info" is saved to a log
file. The log file ATSC30_STL_Status_Info_TX.txt is saved to the directory var/
user/log.

See also, chapter "File and Data Management" in the R&S SMCV100B user manual.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:STL:RESetlog on page 73

General Settings
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Status Info
Displays the ATSC 3.0 coder status by an error message. "No Error" implies correct
behavior of the coder.

If an error occurs, the error message of the ATSC 3.0 coder is displayed. For example,
"Invalid setup (not ATSC 3.0 compliant)" indicates a behavior, that is non-compliant
with the ATSC 3.0 standard.

Status information is also saved to a log file, see "Reset Log File" on page 13. To
ensure correct behavior, fix occurring errors successively.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:STATus? on page 70

3.2  Input Signal Settings

Access:

► Select "Baseband > ATSC 3.0 > Input Signal".

The tab provides settings necessary to configure the input signal.

Input signal tasks

The settings allow you to perform the following tasks:
● Selecting an MPEG TS, ROUTE/DASH, MMT or STL source
● Displaying information about the selected stream (e.g. data rate)
● Configuring the internal MPEG TS test packets or internal IP test packets

Settings:

● General Settings..................................................................................................... 15
● PLP Info.................................................................................................................. 18
● Test Signal Settings.................................................................................................20
● LAN Network Data Settings.................................................................................... 22

Input Signal Settings
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3.2.1  General Settings

Access:

► Select "Input Signal > General".

The tab provides general settings necessary to configure the input signal.

Settings:

Conformance Check..................................................................................................... 15
STL Interface.................................................................................................................15
Reset Log File............................................................................................................... 16
Number of PLPs............................................................................................................16
Source ..........................................................................................................................16
Test Signal.....................................................................................................................17
Destination IP Address..................................................................................................17
Destination IP Port........................................................................................................ 17
Input Type..................................................................................................................... 17
Protocol......................................................................................................................... 17

Conformance Check
Sets the depth of inspection for the conformance check.

"On" Additional in-depth checks are done to ensure that the current config-
uration meets the conformance criteria of the ATSC A/322 PHY layer
specification.

"Off" Checks are done to ensure that the current configuration meets the
basic conformance criteria of the ATSC A/322 PHY layer specifica-
tion.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:CCHeck on page 71

STL Interface
Activates the STL interface.

Input Signal Settings



ATSC 3.0 Configuration and SettingsR&S®SMCVB-K162

16User Manual 1179.0980.02 ─ 03

"On" Uses the incoming STL stream to configure the modulator for single
or multiple PLP transmissions (single or multiple subframes).

"Off" Uses the incoming MPEG transport stream, ROUTE/DASH or MMT
stream directly as payload for single PLP transmission (single sub-
frame).

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:STL:INTerface on page 73

Reset Log File
Requires "STL Interface > On".

Resets the log file.

Status information of the ATSC 3.0 coder as displayed in "Status Info" is saved to a log
file. The log file ATSC30_STL_Status_Info_TX.txt is saved to the directory var/
user/log.

See also, chapter "File and Data Management" in the R&S SMCV100B user manual.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:STL:RESetlog on page 73

Number of PLPs
Displays the number of PLPs.

The number resembles the total number of PLPs in the PHY layer configuration.

The available number of PLPs depends on the setting of "STL Interface":
● If "STL Interface > Off", the number of PLPs is "1" (single PLP).
● If "STL Interface > On", "1 to 64" PLPs are supported.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:NPLP? on page 72

Source
Sets the modulation source for the input signal.

"External" Uses a transport or IP stream, that is input at the local LAN interface.
The "LAN" connector is on the rear panel.
See section "Connecting to LAN" and "Connecting the Instrument to
the Network (LAN)" in the R&S SMCV100B user manual.

"TS Player" Uses an internal transport stream or an IP stream with TS/IP packet
data played from a file. The player requires no option.
Playing encrypted files with extension _c requires a stream library
option R&S SMCVB-KSx.

See also:
● Chapter 3.12, "TS Player", on page 57
● Supported TS player file types

"Test Signal" Requires "STL Interface > Off".
Uses an internal test signal as specified in Chapter 3.2.3, "Test Signal
Settings", on page 20.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SOURce on page 74

Input Signal Settings
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Test Signal
Requires "STL Interface > Off" and "Source > Test Signal".

Defines the test signal data.

"Test TS Packet"
Test signal consists of test TS packets. For configuration, see Chap-
ter 3.2.3, "Test Signal Settings", on page 20.

"Test IP Packet"
Test signal consists of test IP packets. For configuration, see Chap-
ter 3.2.3, "Test Signal Settings", on page 20.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP:INPut:TESTsignal on page 77

Destination IP Address
Sets the destination IP address of the IP connection for external or internal IP data.

Only multicast IPv4 streaming is supported. Therefore, the address range is restricted
to the IPv4 multicast address range, that is 224.0.0.0 to 239.255.255.255.

Note: You can use only IP addresses that are not occupied by the Linux OS or applica-
tions, drivers and services running on the R&S SMCV100B.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:DESTination:IP:ADDRess on page 72

Destination IP Port
Sets the destination IP port of the IP connection for external or internal IP data.

The range is restricted to port numbers 0 to 65535.

Note: You can use only IP ports that are not occupied by the Linux OS or applications,
drivers and services running on the R&S SMCV100B.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:DESTination:IP:PORT on page 72

Input Type
Requires "STL Interface > Off" and "Source > External/TS Player".

Specifies the input type.

"TS" Transport stream using TSoverIP

"IP" IP stream with the following content:
● ROUTE/DASH
● MMT

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:TYPE on page 73

Protocol
Requires one of the following:
● "Source > External"
● "Source > TS Player" and "Input Type > IP"
Displays the used protocol.

"UDP/RTP" Fixed protocol type for "STL Interface > On"

Input Signal Settings
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"UDP" Fixed protocol type for "STL Interface > Off" and "Input Type > IP".

"AUTO" Fixed protocol type for "Source > External", "STL Interface > Off" and
"Input Type > TS".
"AUTO" summarizes "UDP"/"UDP/RTP" support for TSoverIP

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INPut:PROTocol? on page 72

3.2.2  PLP Info

Access:

► Select "Input Signal > PLP Info".

The tab displays the "PLP <num>" table, that contains information.

Settings:

PLP <num> table.......................................................................................................... 18
└ PLP ID.............................................................................................................18
└ Packet Length ................................................................................................18
└ Max. Useful Data Rate / Mbit/s....................................................................... 19
└ Measured Data Rate / Mbit/s.......................................................................... 19
└ Useful Data Rate / Mbit/s................................................................................19

PLP <num> table
Displays individual parameters for each PLP <num>. The table displays information of
up to 64 PLPs with <num> ranging from 0 to 63.

PLP ID ← PLP <num> table
Sets the PLP ID. The PLP ID has to be unique.

Editing the parameter requires "STL Interface > Off".

To edit, select "BICM > General > PLP ID".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:ID on page 81

Packet Length ← PLP <num> table
Requires "STL Interface > Off", "Source > External" and "Input Type > TS".

Displays the packet length of the external transport stream in bytes.

If the packet length does not match the specified length, the output signal is erroneous.
"Packet Length > Invalid" is displayed.

"188" 188 bytes specified packet length.

Input Signal Settings
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"Invalid" Packet length does not match the specified length.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:PACKetlength? on page 75

Max. Useful Data Rate / Mbit/s ← PLP <num> table
Requires "STL Interface > Off" and "Source > External/TS Player".

Displays the maximum data rate, that is derived from the current modulation parameter
settings.

The value is the optimal value at the TSoverIP or IP input interface, that is necessary
for the modulator.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:USEFul[:RATe]:MAX? on page 76

Measured Data Rate / Mbit/s ← PLP <num> table
Requires "STL Interface > Off" and "Source > External".

Displays the measured value of the data rate rmeas of one of the following:
● External transport stream including null packets input at "LAN" connector (TSo-

verIP)
● External IP stream input at "LAN" connector
For TSoverIP input, the value rmeas equals the sum of useful data rate ruseful and the
rate of null packets r0:

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>[:INPut]:DATarate? on page 75

Useful Data Rate / Mbit/s ← PLP <num> table
Requires "STL Interface > On".

Displays the computed values of the PLP data rate.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:USEFul[:RATe]? on page 75

Input Signal Settings
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3.2.3  Test Signal Settings

Access:

► Select "Input Signal > Test Signal".

The tab provides settings necessary to configure the test signal.

Settings:

Test TS Packet.............................................................................................................. 20
Test IP Packet............................................................................................................... 20
PID Test Packet.............................................................................................................21
PID (Hex)...................................................................................................................... 21
Payload Test/Stuff......................................................................................................... 21
PRBS............................................................................................................................ 21

Test TS Packet
Specifies the structure of the test transport stream packet that is fed to the modulator.

"Head/184 Payload"
A sync byte (0x47) followed by three header bytes and 184 payload
bytes.

"Sync/187 Payload"
A sync byte (0x47) followed by 187 payload bytes

Remote command: 
[:SOURce<hw>]:BB:A3TSc:TSPacket on page 77

Test IP Packet
Specifies the structure of the test IP packet that is fed to the modulator.

"Head/UDP Payload"
Fixed payload of 1200 bytes.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:IPPacket on page 77

Input Signal Settings
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PID Test Packet
If a header is present in the test packet ("Test TS Packet > Head/184 Payload"), you
can specify a fixed or variable packet identifier (PID).

"Null" The header of the test transport stream packets has a fixed setting of
null packet header 1FFF (hex).

"Variable" Uses the header value defined with "PID (Hex)" on page 21.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PIDTestpack on page 78

PID (Hex)
Sets the PID.

If "PID Test Packet > Null", "PID (Hex) = 1FFF" is fixed.

If "PID Test Packet > Variable", you can edit the value.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PID on page 78

Payload Test/Stuff
Defines the payload area content of the TS packet.

The TS packet is a test packet. You can select PRBS or exclusively data in hexadeci-
mal format as payload.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PAYLoad on page 77

PRBS
Sets the length of the PRBS sequence.

You can select a PRBS 15 or a PRBS 23 sequence as specified by ITU-T O.151.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PRBS[:SEQuence] on page 78

Input Signal Settings
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3.2.4  LAN Network Data Settings

Access:

► Select "Input Signal > LAN Network Data > Local LAN Interface".

The tab provides "Local LAN Interface" settings necessary to configure network
parameters for IP signals input at the "LAN" connector.

Local LAN Interface.......................................................................................................22

Local LAN Interface
Accesses the network settings tab.

The tab allows you to configure network parameters for IP signal input at the "LAN"
connector.

The settings are also relevant for remote access to the R&S SMCV100B. See the
chapter "Network Settings" in the R&S SMCV100B user manual.

3.3  Encaps Settings

Requires "STL Interface > Off".

Encaps Settings
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Access:

► Select "Baseband > ATSC 3.0 > Encaps".

The tab provides settings necessary to configure encapsulation.

Settings:

PLP ID...........................................................................................................................23
ALP Encapsulation Type............................................................................................... 23
BB Frame Padding........................................................................................................23
BB Frame Counter........................................................................................................ 23

PLP ID
Sets the PLP ID. The PLP ID has to be unique.

Editing the parameter requires "STL Interface > Off".

To edit, select "BICM > General > PLP ID".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:ID on page 81

ALP Encapsulation Type
Displays the input source type of ALP encapsulation.

"IP" Requires "Input Signal > General > Input Type > IP".

"TS" Requires "Input Signal > General > Input Type > TS".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:ALPType? on page 79

BB Frame Padding
Indicates if baseband frame padding is enabled/disabled for the current PLP.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:BBFPadding? on page 79

BB Frame Counter
Enables/disables the baseband frame counter.

The counter is initialized to 0 and increments linearly by one for each baseband packet
of the current PLP.

Encaps Settings
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Independent counters are used for each PLP. When the counter reaches its maximum
value, the next baseband packet counter is reset to zero and the counting process
begins again.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:BBFCounter on page 79

3.4  BICM Settings

Access:

► Select "Baseband > ATSC 3.0 > BICM".

The tab provides settings necessary to configure bit-interleaved coding and modu-
lation (BICM) parameters.

Settings:

● General Settings..................................................................................................... 24
● Interleaving Settings................................................................................................27
● PLP Info.................................................................................................................. 30

3.4.1  General Settings

Access:

► Select "BICM > General".

The tab provides settings necessary to configure the general BICM parameters.

BICM Settings
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Settings:

PLP ID...........................................................................................................................25
Low Level Signaling (LLS)............................................................................................ 25
Layer............................................................................................................................. 25
LDM Injection Level.......................................................................................................25
Size............................................................................................................................... 25
Scrambler Type............................................................................................................. 25
FEC Type...................................................................................................................... 26
Code Rate..................................................................................................................... 26
Constellation................................................................................................................. 26

PLP ID
Sets the PLP ID. The PLP ID has to be unique.

Editing the parameter requires "STL Interface > Off".

To edit, select "BICM > General > PLP ID".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:ID on page 81

Low Level Signaling (LLS)
Displays, if low-level signaling is present in the PLP.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:LLS? on page 83

Layer
Displays the layer, that is used in LDM.

"Core" First layer of a 2-layer LDM system. In a non-LDM system, it is the
only layer.

"Enhanced" Requires "STL Interface > On".
Second layer of a 2-layer LDM system.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:LAYer:LAYer? on page 82

LDM Injection Level
Requires "Layer > Enhanced".

Displays the enhanced layer injection levels relative to the core PLP in dB.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:LAYer:LEVel? on page 82

Size
Displays the number of data cells allocated to the PLP.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:SIZE? on page 83

Scrambler Type
Displays the scrambler type, that is fixed to "0". The entire baseband packet is scram-
bled before forward error correction encoding.

BICM Settings
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Further scrambler types are reserved for future use.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:SCRambler? on page 83

FEC Type
Editing the parameter requires "STL Interface > Off".

Defines the forward error correction (FEC) used for encoding.

The table below illustrates types and coding.

"FEC Type" Outer code Inner code

"BCH+16K" BCH 16200 bits LDPC

"BCH+64K" BCH 64800 bits LDPC

"CRC+16K" CRC 16200 bits LDPC

"CRC+64K" CRC 64800 bits LDPC

"16K only" None 16200 bits LDPC

"64K only" None 64800 bits LDPC

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:FECType on page 81

Code Rate
Editing the parameter requires "STL Interface > Off".

Sets the code rate.

You can set code rates "n/15" with n = 2 to 13.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:RATE on page 83

Constellation
Editing the parameter requires "STL Interface > Off".

Defines the constellation.

You can set a constellation using QPSK modulation or 16/64/256/1024/4096QAM.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:CONStel on page 81

BICM Settings
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3.4.2  Interleaving Settings

Access:

► Select "BICM > Interleaving".

The tab provides settings necessary to configure interleaving.

Settings:

Type.............................................................................................................................. 27
Number of Subslices..................................................................................................... 27
Subslice Interval............................................................................................................28
Time Interleaver Mode.................................................................................................. 28
Extended Interleaving................................................................................................... 28
Depth.............................................................................................................................28
Inter Subframe.............................................................................................................. 28
Cell Interleaver.............................................................................................................. 29
Number of TI Blocks......................................................................................................29
Max. Number of FEC Blocks.........................................................................................29
Number of FEC Blocks..................................................................................................29

Type
Defines the PLP type if the PLP is not an LDM enhanced layer.

"Non-Dispersed"
All data cells have contiguous logical addresses. Subslicing is not
used.
Fixed setting for "STL Interface > Off".

"Dispersed" Not all data cells have contiguous logical addresses. Subslicing is
used.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TYPE:TYPE on page 85

Number of Subslices
Requires "Type > Dispersed".

Defines the number of subslices for a dispersed PLP.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TYPE:NSUBslices on page 85

BICM Settings
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Subslice Interval
Requires "Type > Dispersed".

Defines the difference between the lowest data cell index allocated to a subslice and
the highest data cell index allocated to the immediately preceding subslice within a dis-
persed PLP.

Example: 
The first data cell of the first subslice has index 100, and the subslice interval is 250.
Then the first data cell of the second subslice has index 350 (100 + 250).

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TYPE:SUBSlice[:INTerval]
on page 85

Time Interleaver Mode
Editing the parameter requires "STL Interface > Off".

Sets the time interleaver mode.

"Off" No time interleaving

"CTI" Convolutional time interleaver

"HTI" Hybrid time interleaver

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:TIL on page 86

Extended Interleaving
Requires "Time Interleaver Mode > CTI/HTI" and "General > Constellation > QPSK".

Editing the parameter requires "STL Interface > Off".

If enabled, increases the time interleaving depth.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:EXTended on page 87

Depth
Requires "Time Interleaver Mode > CTI".

Editing the parameter requires "STL Interface > Off".

Defines the time interleaving depths.

"512/724" Always selectable.

"887/1024" Requires "Extended Interleaving > Off".

"1254/1448" Requires "Extended Interleaving > On".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:DEPTh on page 86

Inter Subframe
Requires "Time Interleaver Mode > HTI".

Defines the interleaving frame content and mapping.

BICM Settings
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"On" Each interleaving frame contains one time interleaver block and is
mapped to multiple subframes.

"Off" Each interleaving frame is mapped directly to one subframe, and the
interleaving frame is composed of one or more time interleaver
blocks.
Fixed setting for "STL Interface > Off".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:INTer? on page 87

Cell Interleaver
Requires "Time Interleaver Mode > HTI".

Editing the parameter requires "STL Interface > Off".

Enables or disables the interleaver operating at the cell level.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:CIL on page 88

Number of TI Blocks
Requires "Time Interleaver Mode > HTI".

Editing the parameter requires "STL Interface > Off".

Defines the number of time interleaver blocks or the number of subframes.

The behavior depends on the setting of "Inter Subframe":
● If "Inter Subframe > On", defines the number of subframes over which cells from

one time interleaver (TI) block are carried.
● If "Inter Subframe > Off", defines the number of time interleaver blocks.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:NTIBlocks on page 86

Max. Number of FEC Blocks
Requires "Time Interleaver Mode > HTI".

Displays the maximum number of forward error correction (FEC) blocks per interleav-
ing frame.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:MAXBlocks? on page 87

Number of FEC Blocks
Requires "Time Interleaver Mode > HTI".

Displays the number of forward error correction (FEC) blocks contained in the current
interleaving frame.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:BLOCks? on page 87

BICM Settings
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3.4.3  PLP Info

Access:

► Select "BICM > PLP Info".

The tab displays the "PLP <num>" table, that contains individual PLP information of
up to 64 PLPs.

To configure BICM parameters for "PLP 1"

You can configure BICM parameters of "PLP 1" for single-PLP transmission:

1. Select "ATSC 3.0 > STL Interface > Off".

2. Select "BICM > General/Interleaving".

Settings:

PLP <num> table.......................................................................................................... 30

PLP <num> table
Displays individual parameters for each PLP <num>. The table displays information of
up to 64 PLPs with <num> ranging from 0 to 63.

See "To configure BICM parameters for "PLP 1"" on page 30.

3.5  OFDM Settings

Access:

► Select "Baseband > ATSC 3.0 > OFDM".

The tab provides settings necessary to configure OFDM settings of ATSC 3.0 sub-
frames.

OFDM Settings
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Settings:

● General Settings..................................................................................................... 31
● Symbols Settings.................................................................................................... 34
● Subframe.................................................................................................................35
● Subframe Info..........................................................................................................37

3.5.1  General Settings

Access:

► Select "OFDM > General".

The tab provides to settings necessary to configure the general OFDM settings.

Settings:

Number of Subframes................................................................................................... 31
Channel Bandwidth....................................................................................................... 31
MIMO............................................................................................................................ 32
MISO............................................................................................................................. 32
FFT Size........................................................................................................................32
Reduced Carrier Mode..................................................................................................33
Guard Interval............................................................................................................... 33
Total Number of Data OFDM Symbols..........................................................................33

Number of Subframes
Displays the number of subframes within the current frame.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:FRAMe:NSUBframes? on page 99

Channel Bandwidth
Selects the channel bandwidth.

The channel bandwidth correlates with the used bandwidth, that is smaller. See "Used
Bandwidth" on page 36.

OFDM Settings
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Remote command: 
[:SOURce<hw>]:BB:A3TSc:CHANnel[:BANDwidth] on page 89

MIMO
Displays whether multiple inputs and multiple outputs (MIMO) are used.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:MIMO? on page 90

MISO
Editing the parameter requires "STL Interface > Off".

Defines the multiple inputs and single output (MISO) option.

"Off" No MISO

"64" MISO with 64 coefficients

"256" MISO with 256 coefficients

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:MISO on page 90

FFT Size
Editing the parameter requires "STL Interface > Off".

Defines the FFT size.

Note:
Not all possible combinations of the FFT size with the following parameters are
allowed:
● "Guard Interval" on page 33
● "SISO Pilot Pattern" on page 34

GI pattern "Guard Interval" "FFT Size"

GI1_192 "192" "8K", "16K", "32K"

GI2_384 "384" "8K", "16K", "32K"

GI3_512 "512" "8K", "16K", "32K"

GI4_768 "768" "8K", "16K", "32K"

GI5_1024 "1024" "8K", "16K", "32K"

GI6_1536 "1536" "8K", "16K", "32K"

GI7_2048 "2048" "8K", "16K", "32K"

GI8_2432 "2432" "16K", "32K"

GI9_3072 "3072" "16K", "32K"

GI10_3648 "3648" "16K", "32K"

GI11_4096 "4096" "16K", "32K"

GI12_4864 "4864" "32K"

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:FFT:MODE on page 89

OFDM Settings
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Reduced Carrier Mode
Editing the parameter requires "STL Interface > Off".

Sets a coefficient for reducing the maximum number of carriers.

The coefficient ("0" to "4") is multiplied by a control unit value that depends on the FFT
size used for the subframe. The resulting number is subtracted from the maximum
number of carriers.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:CARRier:MODE on page 89

Guard Interval
Editing the parameter requires "STL Interface > Off".

Sets the guard interval length.

The length is expressed in samples.

Note:
Not all possible combinations of the guard interval with the following parameters are
allowed:
● "FFT Size" on page 32
● "SISO Pilot Pattern" on page 34

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:GUARd:INTerval on page 89

Total Number of Data OFDM Symbols
Editing the parameter requires "STL Interface > Off".

Sets the number of data symbols per subframe, including the subframe boundary sym-
bols, excluding the preamble OFDM symbols.

If "FFT Size > 32K", the sum of the total number of data OFDM symbols and the pre-
amble symbols must be integer.

Note:
The possible setting is restricted depending on the following parameters:
● "FFT Size" on page 32
● "Guard Interval" on page 33
● Maximum allowed frame duration of 5 s
Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:NDATa on page 90

OFDM Settings
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3.5.2  Symbols Settings

Access:

► Select "OFDM > Symbols".

The tab provides settings necessary to configure OFDM symbols.

Settings:

SISO Pilot Pattern......................................................................................................... 34
Pilot Boost Mode........................................................................................................... 34
Subframe Boundary Symbol (First)...............................................................................34
Subframe Boundary Symbol (Last)............................................................................... 35
Subframe Boundary Symbol (Null Cells).......................................................................35
Frequency Interleaver................................................................................................... 35

SISO Pilot Pattern
Editing the parameter requires "STL Interface > Off".

Sets the scattered pilot pattern for single input and single output (SISO).

Note:
Not all possible combinations of the pilot pattern with the following parameters are
allowed:
● "Guard Interval" on page 33
● "FFT Size" on page 32

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PILot:SISO on page 91

Pilot Boost Mode
Editing the parameter requires "STL Interface > Off".

Sets the power boost mode for the scattered pilots.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PILot:BOOSt on page 91

Subframe Boundary Symbol (First)
Defines whether the first symbol of a subframe is a subframe boundary symbol.

OFDM Settings
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Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:SBS:FIRSt on page 92

Subframe Boundary Symbol (Last)
Displays whether the last symbol of a subframe is a subframe boundary symbol.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:SBS:LAST? on page 92

Subframe Boundary Symbol (Null Cells)
Displays the number of null cells in the subframe boundary symbols.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:SBS:NULL? on page 92

Frequency Interleaver
Editing the parameter requires "STL Interface > Off".

Enables/disables the frequency interleaver.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:FIL on page 92

3.5.3  Subframe

Access:

► Select "OFDM > Subframe".

The tab displays the subframe information.

Settings:

Duration.........................................................................................................................36
Used Bandwidth............................................................................................................ 36
Number of PLPs in Subframe....................................................................................... 36
PLP IDs in Subframe.....................................................................................................36

OFDM Settings
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Duration
Displays the duration of the subframe.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:DURation? on page 93

Used Bandwidth
Displays the used bandwidth.

The used bandwidth depends on the following:
● "Channel Bandwidth" on page 31
● "FFT Size" on page 32
● "Reduced Carrier Mode" on page 33

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:USED[:BANDwidth]? on page 94

Number of PLPs in Subframe
Editing the parameter requires "STL Interface > Off".

Displays the number of PLPs in the subframe.

If "STL Interface > Off", the number of PLPs is restricted to 1.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PLP:NPLP? on page 94

PLP IDs in Subframe
Displays all IDs of the PLPs mapped to the subframe. See also "PLP ID" on page 18.

If "STL Interface > Off", the PLP with ID "0" is fixed.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PLP:NIDPlp? on page 94

OFDM Settings
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3.5.4  Subframe Info

Access:

► Select "OFDM > Subfr. Info".

The tab displays information for individual subframes in a table. You can display
information for up to 256 subframes.

To configure parameters for subframe 1

You can configure parameters of "Subframe 1":

1. Select "ATSC 3.0 > STL Interface > Off".

2. Select "BICM > General/Interleaving".

Settings:

Subframe <num> table..................................................................................................37

Subframe <num> table
Displays individual parameters for each subframe <num>. The table displays informa-
tion of up to 21 subframes with <num> ranging from 1 to 21.

See "To configure parameters for subframe 1" on page 37.

3.6  System Settings

Access:

► Select "Baseband > ATSC 3.0 > System".

The tab provides settings necessary to configure ATSC 3.0 system parameters.

System Settings
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Settings:

● Network Settings.....................................................................................................38
● Frame Settings........................................................................................................41
● L1 Settings.............................................................................................................. 43

3.6.1  Network Settings

Access:

► Select "System > Network".

The tab provides network settings.

Settings:

Network Mode............................................................................................................... 38
Low Level Signaling (LLS)............................................................................................ 39
Time Info....................................................................................................................... 39
Return Channel............................................................................................................. 39
Number of Transmitters (N_TX)....................................................................................40
Transmitter Index (x)..................................................................................................... 40
TxID Mode.....................................................................................................................40

└ TxID Address.................................................................................................. 40
└ TxID Injection Level........................................................................................ 40

Broadcast Stream ID (BSID)......................................................................................... 40

Network Mode
Sets the network mode.

Note: GPS receiver required.
Correct SFN synchronization requires a GPS receiver:
● Connect the 1PPS output of the GPS receiver to the "User 2" connector of the

R&S SMCV100B.
● Connect the 10 MHz output of the GPS receiver to the "Ref. In" connector of the

R&S SMCV100B.

System Settings
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At the R&S SMCV100B, set "RF > Reference Frequency > Reference Frequency >
Source > External".

"SFN" Requires "STL Interface > On".
In a single frequency network (SFN), all transmitters in a network are
tuned to the same frequency and have frequency coupling. The fre-
quency is based on the 10 MHz reference output of a GPS receiver.
Also, it is necessary to compensate any signal delays that occur in
the program data supply. Compensation is done by using a GPS
receiver, see also "GPS receiver required" on page 38, and by insert-
ing timestamps into the STL stream. The maximum delay in the net-
work is set on the broadcast gateway. It represents the maximum
delay which can occur in the program data supply at the most remote
transmitter in the network.
If a timestamp was received at the SFN transmitter, its modulator
measures the dynamic delay in relation to its own received seconds
pulse from the local GPS receiver. Using also the processing delay
(of the modulator), the RF delay (from modulator to antenna) and the
optional static delay, the modulator computes the local delay value.
This value expresses the delay which the supplied content stream
must undergo to attain data synchronicity in the network. Note that it
is critical for the incoming content stream to be identical for all trans-
mitters in the network. That means the incoming content stream is not
allowed to change in any way.

"MFN" In a multiple frequency network (MFN), there is no mandatory cou-
pling between an individual transmitter and the incoming content
stream (based on the seconds pulse from a GPS receiver). In addi-
tion, the transmitters are not synchronized with one another based on
a common reference and output frequency. You can select the modu-
lation parameters of the transmitters involved in the network. In addi-
tion, the incoming content stream can be adapted to the data rate
requirements of the modulation parameter settings.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:NETWorkmode on page 96

Low Level Signaling (LLS)
Displays, if low-level signaling is present in the system.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:LLS? on page 96

Time Info
Editing the parameter requires "STL Interface > Off".

Configures the time information.

"ms/us/ns" Signaling precision of the timing information.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:TIME on page 97

Return Channel
Displays, if a dedicated return channel (DRC) is present.

System Settings
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Remote command: 
[:SOURce<hw>]:BB:A3TSc:RETurn[:CHANnel]? on page 97

Number of Transmitters (N_TX)
Sets the number of transmitters for MISO transmission.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:MISo:NTX on page 96

Transmitter Index (x)
Sets the transmitter index for MISO transmission.

The maximum index equals the set "Number of Transmitters (N_TX)".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:MISo:IDX on page 97

TxID Mode
Sets the Tx ID mode.

The mode affects the setting of the "TxID Address" and "TxID Injection Level".

"Off" Disables the Tx ID mode.

"Manual" Enables user-defined setting of "TxID Address" and "TxID Injection
Level [dB]".

"Auto" Requires "STL Interface > On".
Enables user-defined setting of "TxID Address" and displays the
"TxID Injection Level [dB]".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:TXId:MODE on page 97

TxID Address ← TxID Mode
Requires "TxID Mode > Manual/Auto".

Sets the transmitter identification address.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:TXId:ADDRess on page 98

TxID Injection Level ← TxID Mode
Requires "TxID Mode > Manual/Auto".

Sets the injection levels for injecting a TxID signal into the host preamble.

You can minimize the performance degradation of the preamble while maintaining the
desired TxID detection performance.

"Off" Disables Tx ID injection.

"9.0 to 45.0" Enables Tx ID injection. You can set levels in 3 dB steps ranging from
9.0 dB to 45.0 dB.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:TXId:LEVel on page 98

Broadcast Stream ID (BSID)
Requires "Network > L1 > L1 Detail Version > 0", see "L1 Detail Version" on page 44.
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Editing the parameter requires "STL Interface > Off".

Sets the ID of the broadcast stream.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:BSID on page 96

3.6.2  Frame Settings

Access:

► Select "System > Frame".

The tab provides frame settings.

Settings:

Peak To Average Power Ratio...................................................................................... 41
Number of Subframes................................................................................................... 41
Frame Mode..................................................................................................................42
Frame Length................................................................................................................42
Excess Samples per Symbol........................................................................................ 42
Final Excess Samples...................................................................................................42
Additional Samples....................................................................................................... 42
Time Offset....................................................................................................................42

Peak To Average Power Ratio
Editing the parameter requires "STL Interface > Off".

Sets the technique to reduce the peak to average power ratio.

"TR" Reserved tones. If enabled, only zeroes are inserted as the values for
the TR carriers.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:PAPR on page 99

Number of Subframes
Displays the number of subframes within the current frame.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:FRAMe:NSUBframes? on page 99

System Settings
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Frame Mode
Editing the parameter requires "STL Interface > Off".

Sets how the frame length is aligned.

"Time" Time-aligned with excess sample distribution to the guard intervals of
data payload OFDM symbols.

"Symbol" Symbol-aligned with no excess sample distribution.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:FRAMe:MODE on page 100

Frame Length
Requires "Frame Mode > Time".

Editing the parameter requires "STL Interface > Off".

Sets the time period measured from the beginning of the first sample of the bootstrap
to the end of the final sample of the frame.

You can specify frame lengths with a distance of 5 ms between contiguous length val-
ues.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:FRAMe:LENGth on page 100

Excess Samples per Symbol
Requires "Frame Mode > Time".

Displays the additional number of excess samples included in the guard interval of
each non-preamble OFDM symbol of the post-bootstrap portion.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:FRAMe:EXSYmbol? on page 100

Final Excess Samples
Requires "Frame Mode > Time".

Displays the excess samples that are inserted immediately following the final OFDM
symbol of the final subframe.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:FRAMe:EXFinal? on page 100

Additional Samples
Requires "Frame Mode > Symbol".

Displays the number of additional samples added at the end of a frame to facilitate
sampling clock alignment.

If "STL Interface > Off", the parameter is fixed to "0".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:FRAMe:ADDitional[:SAMPles]? on page 101

Time Offset
Requires "Frame Mode > Symbol".

Displays the number of sample periods between the nearest preceding or coincident
millisecond boundary and the leading edge of the frame.
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Remote command: 
[:SOURce<hw>]:BB:A3TSc:FRAMe:TIME[:OFFSet]? on page 101

3.6.3  L1 Settings

Access:

► Select "System > L1".

The tab provides settings necessary to configure common layer 1 (L1) settings.

Settings:

L1 Basic Version........................................................................................................... 43
L1 Basic FEC Type....................................................................................................... 43
L1 Detail Version........................................................................................................... 44
L1 Detail FEC Type....................................................................................................... 44
L1 Detail Additional Parity Mode................................................................................... 44
Number of Preamble Symbols...................................................................................... 44
Reduced Carrier Mode Preamble................................................................................. 44
Pilot Pattern (Dx) Preamble.......................................................................................... 44
Number of RFs..............................................................................................................45

L1 Basic Version
Displays the version of the L1 basic signaling structure that is used for the current
frame.

If "STL Interface > Off", the parameter is fixed to "0".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:L:BASic:VERSion? on page 102

L1 Basic FEC Type
Editing the parameter requires "STL Interface > Off".

Defines the protection level of L1 basic signaling.
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Each categorized mode employs a distinct combination of LDPC code, modulation
order, constellation and shortening/puncturing pattern.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:L:BASic:FECType on page 102

L1 Detail Version
Editing the parameter requires "STL Interface > Off".

Sets the version of the L1 detail signaling structure that is used for the current frame.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:L:DETail:VERSion on page 103

L1 Detail FEC Type
Editing the parameter requires "STL Interface > Off".

Defines the protection level of L1 detail signaling.

Each categorized mode employs a distinct combination of LDPC code, modulation
order, constellation and shortening/puncturing pattern.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:L:DETail:FECType on page 103

L1 Detail Additional Parity Mode
Displays the L1 detail additional parity mode, that is disabled by default.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:L:DETail:ADDitional[:PARity]? on page 103

Number of Preamble Symbols
Displays the total number of OFDM symbols contained in the preamble.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:L:NPReamble[:SYMBols]? on page 103

Reduced Carrier Mode Preamble
Editing the parameter requires "STL Interface > Off".

Sets a coefficient for reducing the maximum number of carriers.

The coefficient is multiplied by a control unit value that depends on the FFT size used
for the preamble. The resulting number is subtracted from the maximum number of
carriers. The reduction applies to all preamble symbols except the first preamble sym-
bol of the current frame.

If there is only one preamble symbol, set the value to zero.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:L:CARRier:MODE on page 102

Pilot Pattern (Dx) Preamble
Editing the parameter requires "STL Interface > Off".

Sets the pilot pattern used for the preamble symbols.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:L:PILot:DX on page 104
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Number of RFs
Displays the number of radio frequencies involved in channel bonding.

A value of "0" means that channel bonding is not used for the current frame.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:NRF? on page 104

3.7  Frame Info

Access:

► Select "Baseband > ATSC 3.0 > Frame Info".

The tab provides settings necessary to configure frame and symbol duration set-
tings.

Settings:

● Frame......................................................................................................................45
● L1 Signaling............................................................................................................ 46
● Bootstrap.................................................................................................................47
● Structure..................................................................................................................49

3.7.1  Frame

Access:

► Select "Frame Info > Frame".

The tab displays frame parameters.

Settings:

Frame Duration............................................................................................................. 46
Bootstrap Duration........................................................................................................ 46

Frame Info
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Frame Duration
Displays the frame duration in ms.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:FRAMe:DURation? on page 105

Bootstrap Duration
Displays the duration of the bootstrap signal in ms.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:DURation? on page 105

3.7.2  L1 Signaling

Access:

► Select "Frame Info > L1 Signaling".

The tab displays signaling length parameters of the common layer 1 (L1).

Settings:

L1 Basic Bytes.............................................................................................................. 46
L1 Detail Bytes.............................................................................................................. 46
L1 Basic Cells............................................................................................................... 47
L1 Detail Cells............................................................................................................... 47

L1 Basic Bytes
Displays the L1 basic signaling length in bytes.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:L:BASic:BYTes? on page 106

L1 Detail Bytes
Displays the L1 detail signaling length in bytes.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:L:DETail:BYTes? on page 106
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L1 Basic Cells
Displays the L1 basic signaling length in cells.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:L:BASic:CELLs? on page 106

L1 Detail Cells
Displays the L1 detail signaling length in cells.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:L:DETail:CELLs? on page 107

3.7.3  Bootstrap

Access:

► Select "Frame Info > Bootstrap".

The tab displays parameters that characterize the bootstrap signal. The bootstrap
signals the information for identifying and initial decoding of the associated signal.

Settings:

Major Version................................................................................................................ 47
Minor Version................................................................................................................ 47
Min. Time to Next.......................................................................................................... 48
Emergency Alert Signaling (EAS)................................................................................. 48
System Bandwidth........................................................................................................ 48
BSR Coefficient.............................................................................................................48

Major Version
Displays the major version of the bootstrap.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:MAJor? on page 109

Minor Version
Displays the minor version of the bootstrap.
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You can change the minor version using the "Special" settings to test the minor ver-
sion. Changing the minor version requires the following:
● "STL Interface > Off"
● "Special > Specifal Settings > On"
● "Special > STL Off. Bootstrap > Minor Version ≠ 0"

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:MINor? on page 109

Min. Time to Next
Displays minimum time interval to the next frame that matches the same major and
minor version number of the current frame.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:TIME:NEXT? on page 110

Emergency Alert Signaling (EAS)
Displays the signaling mode for emergency alert.

You can change the signaling mode using the "Special" settings to test the minor ver-
sion. Changing the signaling mode requires the following:
● "STL Interface > Off"
● "Special > Specifal Settings > On"
● "Special > STL Off: Bootstrap > Emergency Alert Signaling (EAS) ≠ No Emer-

gency"

"No Emergency"
No emergency alert information is available.

"Setting 1/2/3" Emergency alert information is available.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:EAS? on page 108

System Bandwidth
Displays the system bandwidth used for the post-bootstrap portion of the current physi-
cal layer frame.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:BANDwidth? on page 108

BSR Coefficient
Displays the sample rate used for the post-bootstrap portion of the current physical
layer frame.

The displayed value depends on the setting of the STL interface:
● "STL Interface > Off": The value is automatically calculated.
● "STL Interface > On": The value is derived from the input stream data. If the values

differ from "2", "6" or "8", an error message is displayed in the status info of the
ATSC 3.0 coder. See "Status Info" on page 14.

"2" 6.912 MHz at 6 MHz system bandwidth

"5" 8.064 MHz at 7 MHz system bandwidth

"8" 9.216 MHz at 8 MHz system bandwidth

Frame Info



ATSC 3.0 Configuration and SettingsR&S®SMCVB-K162

49User Manual 1179.0980.02 ─ 03

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:BSR:COEFficient? on page 108

3.7.4  Structure

Access:

► Select "Frame Info > Structure".

The tab displays preamble symbols structure parameters.

Settings:

Preamble Structure....................................................................................................... 49
FFT Size........................................................................................................................49
Guard Interval............................................................................................................... 49
Pilot Pattern (Dx)...........................................................................................................50
L1 Basic FEC Type....................................................................................................... 50

Preamble Structure
Displays the structure of the preamble symbols following the last bootstrap symbol.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:PREamble[:STRucture]?
on page 110

FFT Size
Displays the FFT size of the preamble symbols.

If "STL Interface > Off", the FFT size equals the value of "OFDM > General > FFT
Size".

See "FFT Size" on page 32.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:FFT:MODE? on page 109

Guard Interval
Displays the number of guard interval samples of the preamble symbols.
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If "STL Interface > Off", the guard interval equals the value of "OFDM > General >
Guard Interval".

See "Guard Interval" on page 33.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:GUARd:INTerval? on page 109

Pilot Pattern (Dx)
Displays the pilot pattern used for the preamble symbols.

If "STL Interface > Off", the pilot pattern equals the value of "System > L1 > Pilot Pat-
tern (Dx) Preamble".

See "Pilot Pattern (Dx) Preamble" on page 44.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:PILot:DX? on page 110

L1 Basic FEC Type
Displays the FEC type used for the L1 basic signaling in the preamble symbol.

If "STL Interface > Off", the L1 basic FEC type equals the value of "System > L1 > L1
Basic FEC Type".

See "L1 Basic FEC Type" on page 43.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:BASic:FECType? on page 108

3.8  SFN Settings

Requires "STL Interface > On" and "System > Network > Network Mode > SFN".

Access:

► Select "Baseband > ATSC 3.0 > SFN".

The tab provides settings necessary to configure SFN parameters.

Settings

● Delays Settings....................................................................................................... 51
● Mode Settings......................................................................................................... 53

SFN Settings
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3.8.1  Delays Settings

Access:

► Select "SFN > Delays".

The tab provides settings necessary to configure SFN delays.

Settings

Network Delay...............................................................................................................51
Processing Delay.......................................................................................................... 51
Dynamic Delay.............................................................................................................. 52
Total Delay.................................................................................................................... 52
Max. Deviation Time......................................................................................................52
Static Delay................................................................................................................... 52
Maximum Delay............................................................................................................ 52
Dispatch Time............................................................................................................... 52
Mute Bootstrap of Frame.............................................................................................. 52

Network Delay
Displays the time taken for the signal to travel from the playout center to the input of
the signal processing.

The delay depends on the used transmission path. If you use IP fed FEC, the process-
ing time is part of the network delay.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:NETWork? on page 114

Processing Delay
Displays the delay from the modulator input up to the SFN delay (FIFO).

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:PROCess? on page 114

SFN Settings
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Dynamic Delay
Displays the transmission delay currently generated by the SFN delay (FIFO).

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:DYNamic? on page 113

Total Delay
Displays the sum of "Processing Delay" and "Dynamic Delay".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:TOTal? on page 115

Max. Deviation Time
Sets the maximum permissible delay.

The delay Δtmax depends on the time of emission TOEtimestamp from timestamp, the
static delay tstatic and the actual time of emission TOEactual as follows:

Δtmax = TOEtimestamp + tstatic - TOEactual

If the above sum is greater than the "Max. Deviation Time", the SFN delay (FIFO)
restarts. The transmit signal is reset and transmission is restarted.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:DEViation on page 112

Static Delay
Sets the delay to shift the time of transmission positively or negatively.

The static delay is also called User Delay Offset

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:STATic on page 114

Maximum Delay
Displays the time taken for the signal to travel from the playout center to the transmitter
antenna for regular transmission.

The delay is set in the SFN adapter and is the default value for all transmitters in a
dynamic SFN.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:MAXImum? on page 113

Dispatch Time
Displays the time taken for the signal to travel from the playout center to the transmitter
antenna for real transmission.

The delay corresponds to the sum of "Maximum Delay" and "Static Delay". The maxi-
mum delay represents the default value for all transmitters in an SFN. The static delay
represents the transmitter-specific delay.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:DISPatch? on page 112

Mute Bootstrap of Frame
Use the setting for testing SFN operation.
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"On" Replaces the bootstrap by a null signal (no output power).

"Off" The setting is fixed for "STL Interface > Off" and "System > Network
Mode > MFN".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:MUTE[:BOOTstrap] on page 113

3.8.2  Mode Settings

Requires "STL Interface > On" and "System > Network > Network Mode > SFN".

Access:

► Select "Baseband > ATSC 3.0 > SFN".

The tab provides settings necessary to configure the SFN mode.

Settings

SFN Mode..................................................................................................................... 53

SFN Mode
Sets the SFN timestamp operation mode, that is fixed to "SFN Mode > Relative".

Remote command: 
[:SOURce<hw>]:BB:A3TSc:DELay:SFNMode on page 114

SFN Settings
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3.9  Special Settings

Access:

► Select "Baseband > ATSC 3.0 > Special".

The tab provides settings, that differ from the specification of the broadcast stan-
dard.

Settings different from the broadcast standard can be useful for research and develop-
ment. Applying these settings requires "Special Settings > On".
If you set a parameter different from the specification, the warning icon  is displayed
left to the parameter.

Settings:

Special Settings ........................................................................................................... 54
STL On: STL Interface.................................................................................................. 55

└ Preamble Compatibility Mode.........................................................................55
└ TMP Compatibility Mode.................................................................................55

STL Off: Bootstrap.........................................................................................................55
└ Minor Version..................................................................................................55
└ Emergency Alert Signaling (EAS)...................................................................55

STL Off: ALP Encapsulation..........................................................................................55
└ LMT Compatibility Mode................................................................................. 55

Special Settings
Enables/disables special settings.

The setting allows you to switch between standard-compliant and user-defined channel
coding.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SPECial:SETTings[:STATe] on page 116

Special Settings
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STL On: STL Interface
Provides compatibility mode settings.

Preamble Compatibility Mode ← STL On: STL Interface
Sets how the preamble packet is supported.

"On" According to specification ATSC A/324-2016.

"Off" According to specification ATSC A/324-2018 or later.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SPECial:STL:PREamble on page 117

TMP Compatibility Mode ← STL On: STL Interface
Sets how the time & management packet is supported.

"On" According to specification ATSC A/324-2016.

"Off" According to specification ATSC A/324-2018 or later.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SPECial:STL:TMP on page 117

STL Off: Bootstrap
Provides settings that characterize the bootstrap signal.

Minor Version ← STL Off: Bootstrap
Sets the minor version number of the bootstrap.

If "Special settings > On", the minor version sets "Frame Info > Bootstrap > Minor Ver-
sion". See "Minor Version" on page 47.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SPECial:BOOTstrap:MINor on page 117

Emergency Alert Signaling (EAS) ← STL Off: Bootstrap
Sets the signaling for emergency alert.

If "Special settings > On", the signaling mode sets "Frame Info > Bootstrap > Emer-
gency Alert Signaling (EAS)". See "Emergency Alert Signaling (EAS)" on page 48.

"No Emergency"
No emergency alert information is available.

"Setting 1/2/3" Emergency alert information is available.

Remote command: 
[:SOURce<hw>]:BB:A3TSc:SPECial:BOOTstrap:EAS on page 116

STL Off: ALP Encapsulation
Provides ALP encapsulation compatibility mode settings.

LMT Compatibility Mode ← STL Off: ALP Encapsulation
Sets how the LMT signaling is supported.

"On" According to specification ATSC A/330-2016.

"Off" According to specification ATSC A/330-2018 or later.
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Remote command: 
[:SOURce<hw>]:BB:A3TSc:SPECial:ALP:LMT on page 116

3.10  Data Generation Settings

Access:

► Select "Baseband > ATSC 3.0 > Data Generation".

The "Export Data" tab provides settings to generate data of the ATSC 3.0 signal
characteristics. You can generate data for the input signal, BICM and subframing
and OFDM and export the data to a file.

Settings:

Data ..............................................................................................................................56
File Name .....................................................................................................................56
Directory .......................................................................................................................57
Generate ...................................................................................................................... 57
File Info panel................................................................................................................57
PLP <num>/Subr. <num> table.....................................................................................57

Data
Sets the data source, for that the data is generated.

Remote command: 
n.a.

File Name
Displays the file name, for which the data is generated.

Remote command: 
n.a.

Data Generation Settings
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Directory
Accesses the directory of the export data.

A standard "File Select" tab opens.

Remote command: 
n.a.

Generate
Triggers export data generation.

Remote command: 
n.a.

File Info panel
Displays information on the selected file, such as data source, directory and filename.

PLP <num>/Subr. <num> table
Displays the "PLP Info"/"Subfr. Info" data of the corresponding "Data" source.

"PLP <num>" Requires "Data > Input Signal/BICM".

Displays individual parameters for each PLP <num>. The table dis-
plays information of up to 64 PLPs with <num> ranging from 0 to 63.
See "To configure BICM parameters for "PLP 1"" on page 30.

"Subfr. <num>" Requires "Data > Subframing & OFDM".

Displays individual parameters for each subframe <num>. The table
displays information of up to 21 subframes with <num> ranging from 1
to 21.
See "To configure parameters for subframe 1" on page 37.

3.11  Global Connector Settings

The "Input Signal" dialog, the "Trigger/Marker/Clock" dialog and "Trigger In", "Marker"
and "Clock" tabs in "Baseband > ARB/Custom Digital Mod" configuration dialogs pro-
vide quick access to the related connector settings. Click the "Global Connectors" but-
ton to access the settings.

See also chapter "Global Connector Settings" in the user manual.

3.12  TS Player

The "TS Player" application allows you to play stream files for simulation of dedicated
transport stream (TS) scenarios. Also, the R&S SMCV100B offers stream libraries con-

TS Player
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taining stream files with a wide range of ready-made signals for testing systems with
different transmission parameters. For supported file types, see Table 3-1.

Key features

The key features for playing stream files with "TS Player" application are:
● Support of numerous broadcast transmission standards
● Streaming of high-quality video contents
● Streaming of high-quality audio contents
● Efficient use with dedicated streams

Required options

The equipment layout for processing stream files includes:
● Base unit, including arbitrary waveform generator (64 MSample ARB memory, 60

MHz RF bandwidth)
● Broadcast standard option for the "TS Player" application (R&S SMCVB-Kxxx)
● Enable Broadcast Standards option (R&S SMCVB-K519)
● Optional stream library option (R&S SMCVB-KSxx)

For more information, see data sheet.

To access and download a stream library file

The steps to access a stream library and to download stream library files is analogous
as for waveform libraries. See chapter "How to Work with Waveform Libraries" in the
R&S SMCV100B user manual.

For information on the content of a stream library, see the user manual of the stream
library at:

www.rohde-schwarz.com/manual/smcv100b/ksxx-kvxx-stream-and-waveform-libraries-
user-manuals-manuals-gb1_78701-972224.html

To access the "TS Player" application

1. Select "Baseband > ATSC 3.0 > Input Signal".

2. Select "Source > TS Player".

3. Select "TS Player" button.

Opens the TS player dialog, where you can load files.

Support in broadcast standard configuration

Various broadcast baseband standards of the R&S SMCV100B support the "TS
Player" application. For an overview, see the table below.

Baseband standard "Source > TS Player" Baseband standard "Source > TS Player"

"ATSC/ATSC-M/H" Yes "T-DMB/DAB" Yes

"ATSC 3.0" Yes "DVB-S" Yes

TS Player

https://www.rohde-schwarz.com/us/manual/r-s-smcvb-ksxx-kvxx-stream-and-waveform-libraries-user-manuals-manuals-gb1_78701-972224.html
https://www.rohde-schwarz.com/us/manual/r-s-smcvb-ksxx-kvxx-stream-and-waveform-libraries-user-manuals-manuals-gb1_78701-972224.html
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Baseband standard "Source > TS Player" Baseband standard "Source > TS Player"

"DTMB" Yes "DVB-S2" Yes

"DVB-T" Yes "DRM" No

"DVB-T2" Yes "Audio AM" No

"ISDB-T" Yes "Audio FM" No

The remote commands required to define these settings are described in Chapter 4.10,
"TSGen Subsystem", on page 117.

Settings:

● TS Player Settings.................................................................................................. 59
● Player Output Settings............................................................................................ 62
● Seamless Loop Settings......................................................................................... 65

3.12.1  TS Player Settings

Access:

1. Follow the steps in "To access the "TS Player" application" on page 58.

2. Select "TS Player > TS-Player".

The tab provides settings necessary to configure the general settings of the TS
player application.

Settings:

Running/Position Player [hh:mm:ss:fff]......................................................................... 60
Select File..................................................................................................................... 60
Start [hh:mm:ss.fff]........................................................................................................ 61
Position Player [hh:mm:ss.fff]........................................................................................61
Stop [hh:mm:ss.fff]........................................................................................................ 61

TS Player
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Reset Window............................................................................................................... 61
Play............................................................................................................................... 61
Pause............................................................................................................................ 62
Stop...............................................................................................................................62

Running/Position Player [hh:mm:ss:fff]
Displays the current position in time, while playing the file.

You can set an individual position via Position Player [hh:mm:ss.fff].

Remote command: 
:TSGen:CONFigure:SEEK:POSition on page 122

Select File
Provides access to the standard "File Select" function of the instrument. The provided
navigation possibilities in the dialog are self-explanatory.

See also, chapter "File and Data Management" in the R&S SMCV100B User Manual.

The dialog allows you to select user-defined, predefined and recent files. Table 3-1 lists
file extensions of supported files.
Table 3-1: Supported TS player file types

File extension Stream libraries Remark Option

*.atsc_c ATSC/ATSC & Mobile DTV Encrypted R&S SMCVB-KS13

*.dab T-DMB/DAB Unencrypted -

*.dab_c T-DMB/DAB Encrypted R&S SMCVB-KS10

*.dabp_c DAB+ Encrypted R&S SMCVB-KS11

*.eti T-DMB/DAB Unencrypted -

*.xeti T-DMB/DAB Unencrypted -

*.emc_c EMC Encrypted R&S SMCVB-KS15

*.isdbt_c ISDB-T Encrypted R&S SMCVB-KS12

*.pcap - Captured IPv4 stream for ATSC 3.0
player

-

*.t2mi1) - Unencrypted -

*.t2mi_c DVB-T2 MI Encrypted R&S SMCVB-KS14

*.t2trp_c DVB-T2 MI Encrypted R&S SMCVB-KS14

*.trp - Unencrypted -

*.trp_c - Encrypted

Included in various stream libraries

R&S SMCVB-KS12

R&S SMCVB-KS17

R&S SMCVB-KS18

R&S SMCVB-KS19

R&S SMCVB-KS20

*.bin - Unencrypted -

*.ts - Unencrypted -

TS Player
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File extension Stream libraries Remark Option

*.mpg - Unencrypted -

*.t10 - - -

1) For T2MI stream files, the data rate of a T2MI file is determined automatically, if the
following applies:
● Data rate is not part of the TRP file header information.
● PCR information is not available.
● T2MI TRP file is not encrypted, that means not of type *.t2mi_c.
● TRP file has the *.t2mi file extension.

Remote command: 
:TSGen:CONFigure:PLAYfile on page 120
:TSGen:READ:PLAYfile:LENGth? on page 125
:TSGen:READ:FMEMory on page 124

Start [hh:mm:ss.fff]
Sets the start position in the loaded player file. Data which chronologically precedes
the start position is not replayed by the player.

The entered time stamp must chronologically always precede the entry under Stop.

Remote command: 
:TSGen:CONFigure:SEEK:STARt on page 122

Position Player [hh:mm:ss.fff]
Displays the current play position in the file.

Remote command: 
:TSGen:CONFigure:SEEK:POSition on page 122

Stop [hh:mm:ss.fff]
Sets the end position in the player file. Data which chronologically follows the end posi-
tion is not replayed by the player.

When the player reaches the "Stop" position, it returns to the "Start" position (continu-
ous play).

The entered time stamp must chronologically always follow the entry under Play.

Remote command: 
:TSGen:CONFigure:SEEK:STOP on page 123

Reset Window
Resets "Start/Stop/Position Player" parameters.

Remote command: 
:TSGen:CONFigure:SEEK:RESet on page 122

Play
Plays the selected file.

For supported file types, see Table 3-1.

TS Player
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Remote command: 
:TSGen:CONFigure:COMMand<ch> on page 119

Pause
Pauses the player.

After pausing, you can resume playing the file by clicking "Play" again.

Remote command: 
:TSGen:CONFigure:COMMand<ch> on page 119

Stop
Stops the player and returns to the start position.

Remote command: 
:TSGen:CONFigure:COMMand<ch> on page 119

3.12.2  Player Output Settings

Access:

► Select "TS Player > Player Output".

The tab provides settings necessary to configure the output of the TS player.

3.12.2.1  General Settings

The tab provides settings necessary to configure general player output properties.

Data Rate...................................................................................................................... 62
Orig. Data Rate............................................................................................................. 63
Packet Length............................................................................................................... 63
Nullpacket Stuffing........................................................................................................ 63
Stop Data...................................................................................................................... 63

Data Rate
Sets the output data rate of the player.

TS Player
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Note: If "Nullpacket Stuffing > Off", we recommend that you set the output data rate
equal to the original data rate.
If you want to use a different data rate, activate "Nullpacket Stuffing". The function
ensures that the data stream is replayed in the same way as it was recorded. The time
references in the tables of the TS stream are also correct during replay.

Remote command: 
:TSGen:CONFigure:TSRate on page 124

Orig. Data Rate
Displays the calculated original TS data rate.

Remote command: 
:TSGen:READ:ORIGtsrate on page 124

Packet Length
Requires a *.trp, *.trp_c, *.emc or *.emc_c file loaded into the "TS Player" dia-
log. *.trp files are previously recorded files.

Displays the packet length of the loaded TS player file.

Remote command: 
:TSGen:CONFigure:TSPacket on page 124

Nullpacket Stuffing
Requires a *.trp, *.trp_c, *.emc or *.emc_c file loaded into the "TS Player" dia-
log. *.trp files are previously recorded files.

Enables or disables nullpacket stuffing.

The output data rate of the TS player equals the original data rate. The equality
ensures that the time references in the tables of the played TS stream are correct dur-
ing replay.

"On" Activate stuffing, if you need a higher rate than the original data rate.
Null packets are inserted into the data stream.
To ensure correct time references in the stream tables, activate pro-
gram clock reference correction ("PCR, DTS/PTS > On").

"Off" Deactivate stuffing, if you want to use the same data rate as the origi-
nal data rate.

Remote command: 
:TSGen:CONFigure:STUFfing on page 123

Stop Data
Requires a *.trp, *.trp_c, *.emc or *.emc_c file loaded into the "TS Player" dia-
log. *.trp files are previously recorded files.

Ensures that a standardized TS data stream is always output at the TS output at the
rear of the R&S SMCV100B.

In pause or stop status, the TS generator generates "test packets", which have data
and header parts, that can be configured using the Test TS Packet.

Remote command: 
:TSGen:CONFigure:STOPdata on page 123

TS Player
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3.12.2.2  Stuffing Settings

The tab comprises settings necessary to configure stuffing.

Settings

Test TS Packet.............................................................................................................. 64
PID Test Packet.............................................................................................................65
PID (Hex)...................................................................................................................... 65
Payload Test/Stuff......................................................................................................... 65
PRBS............................................................................................................................ 65

Test TS Packet
Specifies the structure of the test transport stream packet that is fed to the modulator.

"Head/184 Payload"
A sync byte (0x47) followed by three header bytes and 184 payload
bytes.

"Sync/187 Payload"
A sync byte (0x47) followed by 187 payload bytes.

"Head/200 Payload"
A sync byte (0x47) followed by three header bytes and 200 payload
bytes.

"Sync/203 Payload"
A sync byte (0x47) followed ) followed by 203 payload bytes.

"Head/204 Payload"
A sync byte (0x47) followed by three header bytes and 204 payload
bytes.

"Sync/207 Payload"
A sync byte (0x47) followed ) followed by 207 payload bytes.

Remote command: 
:TSGen:CONFigure:TSPacket on page 124

TS Player
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PID Test Packet
If a header is present in the test packet ("Test TS Packet > Head/184 Payload"), you
can specify a fixed or variable packet identifier (PID).

"Null" The header of the test transport stream packets has a fixed setting of
null packet header 1FFF (hex).

"Variable" Uses the header value defined with PID (Hex).

Remote command: 
:TSGen:CONFigure:PIDTestpack on page 120

PID (Hex)
Sets the PID.

If "PID Test Packet > Null", "PID (Hex) = 1FFF" is fixed.

If "PID Test Packet > Variable", you can edit the value.

Remote command: 
:TSGen:CONFigure:PID on page 120

Payload Test/Stuff
Defines the payload area content of the TS packet.

"PRBS" PRBS data in accordance with ITU-T O.151
See also chapter "Internal Modulation Data" in the R&S SMCV100B
User Manual.

"0x00" Exclusively 00 (hex) data

"0xFF" Exclusively FF (hex) data

Remote command: 
:TSGen:CONFigure:PAYLoad on page 120

PRBS
Sets the length of the PRBS sequence.

You can select a PRBS 15 or a PRBS 23 sequence as specified by ITU-T O.151.

Remote command: 
:TSGen:CONFigure:PRBS[:SEQuence] on page 121

3.12.3  Seamless Loop Settings

Displaying the tab requires a *.trp, *.trp_c, *.emc or *.emc_c file loaded into the
"TS Player" dialog. *.trp files are previously recorded files.

TS Player
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Access:

► Select "TS Player > Seamless Loop".

The tab provides settings necessary to configure settings for playing the file in a
loop.

Settings:

Continuity Counter........................................................................................................ 66
PCR, DTS/PTS............................................................................................................. 66
TDT/TOT....................................................................................................................... 66

Continuity Counter
Activates the correction of the continuity counters in the replayed TS data stream. The
correction allows you to decode the stream without interruption when the play file is
looping.

Remote command: 
:TSGen:CONFigure:SEAMless:CC on page 121

PCR, DTS/PTS
Activates the correction of time stamps in the replayed TS data stream. The correction
allows you to decode the stream without interruption when the play file is looping.

If you set "Nullpacket Stuffing = On" and "PCR, DTS/PTS = On", the time stamps in the
streams are corrected when nullpackets are inserted into the stream.

Remote command: 
:TSGen:CONFigure:SEAMless:PCR on page 121

TDT/TOT
Activates the correction of the time and date table in the replayed TS data stream. The
correction allows you to decode the stream without interruption when the play file is
looping.

Remote command: 
:TSGen:CONFigure:SEAMless:TT on page 122
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4  Remote-Control Commands
The following commands are required to generate signals with the ATSC 3.0 option in
a remote environment. We assume that the R&S SMCV100B has already been set up
for remote operation in a network as described in the R&S SMCV100B documentation.
A knowledge about the remote control operation and the SCPI command syntax is
assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section"Remote-Control Commands" in the R&S SMCV100B user manual.

Common suffixes

The following common suffixes are used in the remote commands:

Suffix Value range Description

SOURce<hw> 1 Available baseband signals

PLP<ch> 1 to 64 Available number of PLPs

SUBFrame<ch> 1 to 256 Available number of subframes

Programming examples

This description provides simple programming examples. The purpose of the examples
is to present all commands for a given task. In real applications, one would rather
reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the example
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument preset/reset is rec-
ommended to set the instrument to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

The following commands specific to the ATSC 3.0 are described here:

● General Commands................................................................................................68
● Input Signal Commands..........................................................................................70
● Encapsulation Commands...................................................................................... 78
● BICM Commands....................................................................................................80
● OFDM and Subframe Commands...........................................................................88
● System Commands.................................................................................................94
● Frame Info Commands......................................................................................... 104
● SFN Delay Commands..........................................................................................111
● Special Commands............................................................................................... 115
● TSGen Subsystem................................................................................................ 117
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4.1  General Commands

Example: Storing current configuration
:SOURce1:BB:A3TSc:SETTing:STORe "/var/user/my_atsc30"
// Saves the file "my_atsc30.a3tsc" in the directory as above.

*RST

:SOURce1:BB:A3TSc:SETTing:CATalog?
// Response: my_atsc30
:SOURce1:BB:A3TSc:SETTing:LOAD "/var/user/my_atsc30"
:SOURce1:BB:A3TSc:STATe 1
:SOURce1:BB:A3TSc:SETTing:DELete "/var/user/my_atsc30"

Commands

[:SOURce<hw>]:BB:A3TSc:PRESet...................................................................................68
[:SOURce<hw>]:BB:A3TSc:STATe.....................................................................................68
[:SOURce<hw>]:BB:A3TSc:SETTing:CATalog.....................................................................69
[:SOURce<hw>]:BB:A3TSc:SETTing:DELete......................................................................69
[:SOURce<hw>]:BB:A3TSc:SETTing:LOAD........................................................................69
[:SOURce<hw>]:BB:A3TSc:SETTing:STORe......................................................................69
[:SOURce<hw>]:BB:A3TSc:INPut:STATus?........................................................................ 70

[:SOURce<hw>]:BB:A3TSc:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:A3TSc:STATe.

Example: See Example "Storing current configuration" on page 68.

Usage: Event

Manual operation: See "Set To Default" on page 12

[:SOURce<hw>]:BB:A3TSc:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Storing current configuration" on page 68.

Manual operation: See "State" on page 12

General Commands
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[:SOURce<hw>]:BB:A3TSc:SETTing:CATalog

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.a3tsc.

Return values: 
<FileNames> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Example: See Example "Storing current configuration" on page 68.

Manual operation: See "Save/Recall" on page 12

[:SOURce<hw>]:BB:A3TSc:SETTing:DELete <Delete>

Deletes the selected file from the default or the specified directory. Deleted are files
with extension *.a3tsc.

Setting parameters: 
<Delete> "<filename>"

Filename or complete file path; file extension can be omitted

Example: See Example "Storing current configuration" on page 68.

Usage: Setting only

Manual operation: See "Save/Recall" on page 12

[:SOURce<hw>]:BB:A3TSc:SETTing:LOAD <Atsc30Recall>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.a3tsc.

Parameters:
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted

Example: See Example "Storing current configuration" on page 68.

Manual operation: See "Save/Recall" on page 12

[:SOURce<hw>]:BB:A3TSc:SETTing:STORe <Atsc30Save>

Saves the current settings into the selected file; the file extension (*.a3tsc) is
assigned automatically.

Parameters:
<Filename> string

Filename or complete path

Example: See Example "Storing current configuration" on page 68.

Manual operation: See "Save/Recall" on page 12

General Commands
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[:SOURce<hw>]:BB:A3TSc:INPut:STATus?

Queries the ATSC 3.0 coder status.

Return values: 
<Status> string

Example: See Example "Configuring general input signal parameters"
on page 70.

Usage: Query only

Manual operation: See "Status Info" on page 14

4.2  Input Signal Commands

● General Commands................................................................................................70
● PLP Info Commands...............................................................................................74
● Test Signal Commands........................................................................................... 76

4.2.1  General Commands

Example: Configuring general input signal parameters
:SOURce1:BB:A3TSc:SOURce EXT
:SOURce1:BB:A3TSc:INPut:CCHeck ON

//********************************************************************************
// Incoming MPEG-2, ROUTE/DASH, MMT stream
//********************************************************************************
:SOURce1:BB:A3TSc:INPut:STL:INTerface ON
// Input IP content stream for direct single PLP single subframe transmission

//********************************************************************************
// Incoming studio transmitter link (STL) stream
//********************************************************************************
:SOURce1:BB:A3TSc:INPut:STL:INTerface ON
// Input IP stream for single/multiple PLP single/multiple subframe transmission
:SOURce1:BB:A3TSc:INPut:STL:RESetlog

Example: Configuring local LAN parameters
//******************************************************************************
// Check the connection of the R&S SMCV100B in the LAN
//******************************************************************************
:SYSTem:COMMunicate:NETWork:STATus?
// 1
:SYSTem:PROTect1:STATe OFF,123456

Input Signal Commands
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:SYSTem:COMMunicate:NETWork:IPADdress:MODE STAT
:SYSTem:COMMunicate:NETWork:IPADdress "10.113.0.104"
:SYSTem:COMMunicate:NETWork:IPADdress:DNS "10.0.2.166"
:SYSTem:COMMunicate:NETWork:COMMon:HOSTname?
// "SMCV100B-102030"
:SYSTem:COMMunicate:NETWork:COMMon:WORKgroup "instrument"
:SYSTem:COMMunicate:NETWork:COMMon:DOMain "rsint.net"
:SYSTem:COMMunicate:NETWork:IPADdress:GATeway "10.113.0.1"
:SYSTem:COMMunicate:NETWork:IPADdress:SUBNet:MASK "255.255.252.0"
:SYSTem:COMMunicate:NETWork:MACaddress?
// Response: "08 00 27 a3 a1 70"
:SYSTem:PROTection1:STATe ON

//********************************************************************************
// Prepare for IP based MPEG-2, ROUTE/DASH, MMT stream input
//********************************************************************************
:SOURce1:BB:A3TSc:INPut:TYPE?
// TS
:SOURce1:BB:A3TSc:INPut:TYPE IP
:SOURce1:BB:A3TSc:INPut:DESTination:IP:ADDRess "239.255.10.10"
:SOURce1:BB:A3TSc:INPut:DESTination:IP:PORT 5001

//********************************************************************************
// Query incoming stream properties
//********************************************************************************
:SOURce1:BB:A3TSc:INPut:NPLP?
// Response: 1
:SOURce1:BB:A3TSc:INPut:PROTocol?
// Response: UDP
:SOURce1:BB:A3TSc:INPut:STATus?
// Response: no error

Commands

[:SOURce<hw>]:BB:A3TSc:INPut:CCHeck......................................................................... 71
[:SOURce<hw>]:BB:A3TSc:INPut:DESTination:IP:ADDRess................................................72
[:SOURce<hw>]:BB:A3TSc:INPut:DESTination:IP:PORT..................................................... 72
[:SOURce<hw>]:BB:A3TSc:INPut:NPLP?...........................................................................72
[:SOURce<hw>]:BB:A3TSc:INPut:PROTocol?.....................................................................72
[:SOURce<hw>]:BB:A3TSc:INPut:STL:INTerface................................................................ 73
[:SOURce<hw>]:BB:A3TSc:INPut:STL:RESetlog.................................................................73
[:SOURce<hw>]:BB:A3TSc:INPut:TYPE.............................................................................73
[:SOURce<hw>]:BB:A3TSc:SOURce................................................................................. 74

[:SOURce<hw>]:BB:A3TSc:INPut:CCHeck <ConfCheck>

Sets the depth of inspection for the conformance check.

Parameters:
<ConfCheck> 0 | 1 | OFF | ON

Input Signal Commands
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Example: See Example "Configuring general input signal parameters"
on page 70.

Manual operation: See "Conformance Check" on page 15

[:SOURce<hw>]:BB:A3TSc:INPut:DESTination:IP:ADDRess <DestIPAddress>

Sets the destination IP address of the IP connection for external or internal IP data.

Parameters:
<DestIPAddress> string

Range: 224.0.0.0  to  239..255.255.255
*RST: 239..255.10.10

Example: See Example "Configuring local LAN parameters" on page 70.

Manual operation: See "Destination IP Address" on page 13

[:SOURce<hw>]:BB:A3TSc:INPut:DESTination:IP:PORT <DestIPPort>

Sets the destination IP port of the IP connection for external or internal IP data.

Parameters:
<DestIPPort> integer

Range: 0  to  65535
*RST: 5001

Example: See Example "Configuring local LAN parameters" on page 70.

Manual operation: See "Destination IP Port" on page 13

[:SOURce<hw>]:BB:A3TSc:INPut:NPLP?

Queries the number of PLPs, that is the total number of the PHY layer configuration.

Return values: 
<NumberPLP> integer

Range: 1  to  64
*RST: 1

Example: See Example "Configuring general input signal parameters"
on page 70.

Usage: Query only

Manual operation: See "Number of PLPs" on page 16

[:SOURce<hw>]:BB:A3TSc:INPut:PROTocol?

Displays the used protocol.

Return values: 
<Protocol> UDP | RTP | AUTO

Input Signal Commands
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UDP
Protocol type for IP-based stream (ROUTE, DASH or MMT) with
deactivated STL interface.
UDP|RTP
Protocol type for IP-based STL stream with activated STL inter-
face.
AUTO
Protocol type is UDP or UDP/RTP for IP-based transport stream
(TSoverIP) with deactivated STL interface.

Example: See Example "Configuring local LAN parameters" on page 70.

Usage: Query only

Manual operation: See "Protocol" on page 17

[:SOURce<hw>]:BB:A3TSc:INPut:STL:INTerface <STLInterface>

Activates the STL interface.

Parameters:
<STLInterface> 0 | 1 | OFF | ON

Example: See Example "Configuring general input signal parameters"
on page 70.

Manual operation: See "STL Interface" on page 12

[:SOURce<hw>]:BB:A3TSc:INPut:STL:RESetlog

Resets the log file.

Parameters:
<ResetLogFile> select

Example: See Example "Configuring general input signal parameters"
on page 70.

Manual operation: See "Reset Log File" on page 13

[:SOURce<hw>]:BB:A3TSc:INPut:TYPE <InputType>

Specifies the input type.

Parameters:
<InputType> IP | TS

*RST: TS

Example: See Example "Configuring local LAN parameters" on page 70.

Manual operation: See " Input Type" on page 17

Input Signal Commands
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[:SOURce<hw>]:BB:A3TSc:SOURce <Source>

Sets the modulation source for the input signal.

Parameters:
<Source> EXTernal | TSPLayer | TESTsignal

*RST: EXTernal

Example: See Example "Configuring general input signal parameters"
on page 70.

Manual operation: See " Source " on page 16

4.2.2  PLP Info Commands

Example: Querying PLP input properties
:SOURce1:BB:A3TSc:SOURCe EXT

//********************************************************************************
// Incoming IP based ROUTE/DASH or MMT stream
//********************************************************************************
:SOURce1:BB:A3TSc:INPut:TYPE IP
:SOURce1:BB:A3TSc:PLP1:ID?
// Response: 0
:SOURce1:BB:A3TSc:PLP1:USEFul:RATe:MAX?
// 19392659 Bit/s
:SOURce1:BB:A3TSc:PLP1:INPut:DATArate?
// 18765432 Bit/s

//********************************************************************************
// Incoming IP based MPEG-2 stream (TSoverIP)
//********************************************************************************
:SOURce1:BB:A3TSc:INPut:TYPE TS
:SOURce1:BB:A3TSc:PLP1:ID?
// Response: 0
:SOURce1:BB:A3TSc:PLP1:PACKetlength?
// Response: P188
:SOURce1:BB:A3TSc:PLP1:USEFul:RATe:MAX?
// 19392659 Bit/s
:SOURce1:BB:A3TSc:PLP1:INPut:DATArate?
// 18765432 Bit/s

Commands

[:SOURce<hw>]:BB:A3TSc:PLP<ch>[:INPut]:DATarate?...................................................... 75
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:PACKetlength?..........................................................75
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:USEFul[:RATe]?.........................................................75
[:SOURce<hw>]:BB:A3TSc:PLP<ch>:USEFul[:RATe]:MAX?.................................................76
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[:SOURce<hw>]:BB:A3TSc:PLP<ch>[:INPut]:DATarate?

Queries the measured value of the data rate of one of the following:
● External transport stream including null packets input at "LAN" connector (TSo-

verIP)
● External IP stream input at "LAN" connector

Return values: 
<MeasuredDR> float

Range: 0  to  999999999
Increment: 1
*RST: 0

Example: See Example "Querying PLP input properties" on page 74.

Usage: Query only

Manual operation: See "Measured Data Rate / Mbit/s" on page 19

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:PACKetlength?

Queries the packet length of the external transport stream in bytes.

Return values: 
<PacketLength> P188 | INValid

P188
188 bytes specified packet length.
INValid
Packet length does not match the specified length.
*RST: INValid

Example: See Example "Querying PLP input properties" on page 74.

Usage: Query only

Manual operation: See " Packet Length " on page 18

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:USEFul[:RATe]?

Queries the computed values of the PLP data rate.

Return values: 
<UsefulDR> float

Range: 0  to  999999999
Increment: 1
*RST: 0

Example: See Example "Querying PLP input properties" on page 74.

Usage: Query only

Manual operation: See "Useful Data Rate / Mbit/s" on page 19
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[:SOURce<hw>]:BB:A3TSc:PLP<ch>:USEFul[:RATe]:MAX?

Queries the maximum data rate, that is derived from the current modulation parameter
settings.

The value is the optimal value at the TSoverIP or IP input interface, that is necessary
for the modulator.

Return values: 
<MaxUsefulDR> float

Range: 0  to  999999999
Increment: 1
*RST: 0

Example: See Example "Querying PLP input properties" on page 74.

Usage: Query only

Manual operation: See "Max. Useful Data Rate / Mbit/s" on page 19

4.2.3  Test Signal Commands

Example: Configuring test signal parameters
:SOURce1:BB:A3TSc:SOURce TEST

//******************************************************************************
// Set test IP packets as test signal.
//******************************************************************************
:SOURce1:BB:A3TSc:PLP1:INPut:TESTsignal TIPP
:SOURce1:BB:A3TSc:IPPacket?
// Response: HUDP
//******************************************************************************
// Set test TS packets as test signal.
//******************************************************************************
:SOURce1:BB:A3TSc:PLP1:INPut:TESTsignal TTSP
:SOURce1:BB:A3TSc:TSPacket H184

//******************************************************************************
// Specify more test signal properties.
//******************************************************************************
:SOURce1:BB:A3TSc:PIDTestpack NULL
:SOURce1:BB:A3TSc:PID?
// "8191" in decimal representation
// "1FFF" in hexadecimal representation
:SOURce1:BB:A3TSc:PIDTestpack VAR
:SOURce1:BB:A3TSc:PID 4607
// Corresponds to "11FF" in hexadecimal representation.
:SOURce1:BB:A3TSc:PAYLoad PRBS
:SOURce1:BB:A3TSc:PRBS:SEQuence P23_1
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[:SOURce<hw>]:BB:A3TSc:PLP:INPut:TESTsignal <TestSignal>

Defines the test signal data.

Parameters:
<TestSignal> TTSP | TIPP

*RST: TTSP

Example: See Example "Configuring test signal parameters" on page 76.

Manual operation: See "Test Signal" on page 17

[:SOURce<hw>]:BB:A3TSc:IPPacket <TestIPPacket>

Specifies the structure of the test IP packet that is fed to the modulator.

Parameters:
<TestIPPacket> HUDP

Example: See Example "Configuring test signal parameters" on page 76.

Manual operation: See "Test IP Packet" on page 20

[:SOURce<hw>]:BB:A3TSc:TSPacket <TSPacket>

Specifies the structure of the test transport stream packet that is fed to the modulator.

Parameters:
<TSPacket> S187 | H184

*RST: H184

Example: See Example "Configuring test signal parameters" on page 76.

Manual operation: See "Test TS Packet" on page 20

[:SOURce<hw>]:BB:A3TSc:PAYLoad <Payload>

Defines the payload area content of the TS packet.

Parameters:
<Payload> H00 | HFF | PRBS

*RST: PRBS

Example: See Example "Configuring test signal parameters" on page 76.
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Manual operation: See "Payload Test/Stuff" on page 21

[:SOURce<hw>]:BB:A3TSc:PID <PID>

Sets the PID.

Parameters:
<PID> integer

Range: #H0000  to  #H1FFF
*RST: #H1FFF

Example: See Example "Configuring test signal parameters" on page 76.

Manual operation: See "PID (Hex)" on page 21

[:SOURce<hw>]:BB:A3TSc:PIDTestpack <PIDTestpacket>

If a header is present in the test packet ("Test TS Packet > Head/184 Payload"), you
can specify a fixed or variable packet identifier (PID).

Parameters:
<PIDTestpacket> VARiable | NULL

*RST: NULL

Example: See Example "Configuring test signal parameters" on page 76.

Manual operation: See "PID Test Packet" on page 21

[:SOURce<hw>]:BB:A3TSc:PRBS[:SEQuence] <PRBS>

Sets the length of the PRBS sequence.

You can select a PRBS 15 or a PRBS 23 sequence as specified by ITU-T O.151.

Parameters:
<PRBS> P15_1 | P23_1

*RST: P23_1

Example: See Example "Configuring test signal parameters" on page 76.

Manual operation: See "PRBS" on page 21

4.3  Encapsulation Commands

Example: Configuring encapsulation parameters
:SOURce1:BB:A3TSc:PLP1:ID?
// Response: 0

Encapsulation Commands
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:SOURce1:BB:A3TSc:PLP1:ALPType?
// Response: TS
// For encapsulation of MPEG-2 transport stream.
// Response: IP
// For encapsulation of ROUTE/DAHS or MMT IP stream.
:SOURce1:BB:A3TSc:PLP1:BBFPadding?
// Response: 1
// Baseband frame padding is enabled for PLP 1.

Commands
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[:SOURce<hw>]:BB:A3TSc:PLP<ch>:ALPType?

Queries the input source type of ALP encapsulation.

Return values: 
<ALPEncapsType> IP | TS

IP
Query result for IP-based input via
SOURce1:BB:A3TSc:INPut:TYPe IP
TS
Query result for serial input via
SOURce1:BB:A3TSc:INPut:TYPe TS

Example: See Example "Configuring encapsulation parameters"
on page 78.

Usage: Query only

Manual operation: See "ALP Encapsulation Type" on page 23

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:BBFCounter <BBFrameCounter>

Enables/disables the baseband frame counter.

The counter is initialized to 0 and increments linearly by one for each baseband packet
of the current PLP.

Parameters:
<BBFrameCounter> 0 | 1 | OFF | ON

Example: See Example "Configuring encapsulation parameters"
on page 78.

Manual operation: See "BB Frame Counter" on page 23

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:BBFPadding?

Queries, if baseband frame padding is enabled/disabled for the current PLP.
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Return values: 
<BBFramePadding> 0 | 1 | OFF | ON

Example: See Example "Configuring encapsulation parameters"
on page 78.

Usage: Query only

Manual operation: See "BB Frame Padding" on page 23

4.4  BICM Commands

The section contains the commands for configuring BICM.

● General Commands................................................................................................80
● Interleaving Commands.......................................................................................... 84

4.4.1  General Commands

Example: Configuring general BICM parameters
//********************************************************************************
// Set PLP ID for PLP 1.
//********************************************************************************
:SOURce1:BB:A3TSc:PLP1:ID 1

//********************************************************************************
// Set coding and constellation for PLP 1.
//********************************************************************************
:SOURce1:BB:A3TSc:PLP1:FECType B64K
:SOURce1:BB:A3TSc:PLP1:RATE R9_15
:SOURce1:BB:A3TSc:PLP1:CONStel T4096

//********************************************************************************
// Query properties for PLP 2.
// If STL Interface = Off you can only set/query PLP1 parameters.
// If STL Interface = On you can query parameters of all PLPs, no setting.
//********************************************************************************
:SOURce1:BB:A3TSc:INPut:STL:INTerface?
// Response: 0

:SOURce1:BB:A3TSc:PLP2:LLS?
// Response: ABSent
:SOURce1:BB:A3TSc:PLP2:LAYer:LAYer?
// Response: ENHanced
// Second layer of a 2-layer LDM system
:SOURce1:BB:A3TSc:PLP2:LAYer:LEVel?
// Response: L40
// Injection level of 4.0 dB
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:SOURce1:BB:A3TSc:PLP2:SIZE?
// Response: 1314804
:SOURce1:BB:A3TSc:PLP2:SCRambler?
// Response: 0
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[:SOURce<hw>]:BB:A3TSc:PLP<ch>:ID <PLPID>

Sets the PLP ID. The PLP ID has to be unique.

Parameters:
<PLPID> integer

Range: 0  to  63
*RST: 0

Example: See Example "Configuring general BICM parameters"
on page 80.

Manual operation: See "PLP ID" on page 18

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:CONStel <Constellation>

Defines the constellation.

Parameters:
<Constellation> T4 | T16 | T64 | T256 | T1024 | T4096

T4
QPSK
T16|T64|T256|T1024|T4096
16/64/256/1024/4096QAM

Example: See Example "Configuring general BICM parameters"
on page 80.

Manual operation: See "Constellation" on page 26

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:FECType <FECType>

Defines the forward error correction (FEC) used for encoding.

The table below illustrates types and coding.
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<FEC Type> Outer code Inner code

B16K BCH 16200 bits LDPC

B64K BCH 64800 bits LDPC

C16K CRC 16200 bits LDPC

C64K CRC 64800 bits LDPC

O16K None 16200 bits LDPC

O64K None 64800 bits LDPC

Parameters:
<FECType> B16K | B64K | C16K | C64K | O16K | O64K

Example: See Example "Configuring general BICM parameters"
on page 80.

Manual operation: See "FEC Type" on page 26

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:LAYer:LAYer?

Queries the layer, that is used in LDM.

Return values: 
<Layer> ENHanced | CORE

Example: See Example "Configuring general BICM parameters"
on page 80.

Usage: Query only

Manual operation: See "Layer" on page 25

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:LAYer:LEVel?

Queries the enhanced layer injection levels relative to the core PLP in dB.

Return values: 
<LDMInjLevel> L00 | L05 | L10 | L15 | L20 | L25 | L30 | L35 | L40 | L45 | L50 |

L60 | L70 | L80 | L90 | L100 | L110 | L120 | L130 | L140 | L150 |
L160 | L170 | L180 | L190 | L200 | L210 | L220 | L230 | L240 |
L250
Level L<x> with <x>/10 meaning the level in dB

Example: L40 means 4.0 dB

Example: See Example "Configuring general BICM parameters"
on page 80.

Usage: Query only

Manual operation: See "LDM Injection Level" on page 25
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[:SOURce<hw>]:BB:A3TSc:PLP<ch>:LLS?

Displays, if low-level signaling is present in the PLP.

Return values: 
<LowLevelSignali> ABSent | PRESent

Example: See Example "Configuring general BICM parameters"
on page 80.

Usage: Query only

Manual operation: See "Low Level Signaling (LLS)" on page 25

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:RATE <CodeRate>

Sets the code rate.

Parameters:
<CodeRate> R2_15 | R3_15 | R4_15 | R5_15 | R6_15 | R7_15 | R8_15 |

R9_15 | R10_15 | R11_15 | R12_15 | R13_15

Example: See Example "Configuring general BICM parameters"
on page 80.

Manual operation: See "Code Rate" on page 26

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:SCRambler?

Queries the scrambler type, that is fixed to "0". The entire baseband packet is scram-
bled before forward error correction encoding.

Return values: 
<ScramblerType> integer

Range: 0  to  3
*RST: 0

Example: See Example "Configuring general BICM parameters"
on page 80.

Usage: Query only

Manual operation: See "Scrambler Type" on page 25

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:SIZE?

Queries the number of data cells allocated to the PLP.

Return values: 
<Size> integer

Range: 0  to  16777215
*RST: 0

Usage: Query only
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Manual operation: See "Size" on page 25

4.4.2  Interleaving Commands

Example: Configure interleaving parameters
//********************************************************************************
// Non-dispersed PLPs
//********************************************************************************
:SOURce1:BB:A3TSc:PLP1:TYPE:TYPE? 
// Response: NONDispersed

//********************************************************************************
// Dispersed PLPs
//********************************************************************************
:SOURce1:BB:A3TSc:PLP1:TYPE:TYPE? 
// Response: DISPersed
:SOURce1:BB:A3TSc:PLP1:TYPE:NSUBslices?
// Response: 53
:SOURce1:BB:A3TSc:PLP1:TYPE:SUBSlice:INTerval?
// Response: 25151

//********************************************************************************
// Time Interleaver = OFF setting
//********************************************************************************
:SOURce1:BB:A3TSc:PLP1:TIL:TIL OFF
// Sets time interleaver off.

//********************************************************************************
// Time Interleaver = CTI setting
//********************************************************************************
:SOURce1:BB:A3TSc:PLP1:TIL:TIL CTI
// Sets a convolutional time interleaver.
:SOURce1:BB:A3TSc:PLP1:CONStellation?
// Response: T4
// T4 means QPSK. For this constellation, you can enable extended interleaving:
:SOURce1:BB:A3TSc:PLP1:TIL:EXTended ON
// Extended interleaving allows for increased interleaving depth:
:SOURce1:BB:A3TSc:PLP1:TIL:DEPTh?
// Response: D1448

//********************************************************************************
// Time Interleaver = HTI setting
//********************************************************************************
:SOURce1:BB:A3TSc:PLP1:TIL:TIL HTI
// Sets a hybrid time interleaver.
:SOURce1:BB:A3TSc:PLP1:TIL:INTer?
// Response: 0
// Each interleaving frame is mapped directly to one subframe.
:SOURce1:BB:A3TSc:PLP1:TIL:NTIBlocks 16
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// Sets 16 time interleaver blocks.
:SOURce1:BB:A3TSc:PLP1:TIL:MAXBlocks?
// Response: 42
:SOURce1:BB:A3TSc:PLP1:TIL:BLOCks?
// Response: "42"
:SOURce1:BB:A3TSc:PLP1:TIL:CIL ON
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[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TYPE:TYPE <Type>

Defines the PLP type if the PLP is not an LDM enhanced layer.

Parameters:
<Type> DISPersed | NONDispersed

Example: See Example "Configure interleaving parameters" on page 84.

Manual operation: See "Type" on page 27

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TYPE:NSUBslices <NumberSubslices>

Defines the number of subslices for a dispersed PLP.

Parameters:
<NumberSubslices> integer

Range: 1  to  16384
*RST: 2

Example: See Example "Configure interleaving parameters" on page 84.

Manual operation: See "Number of Subslices" on page 27

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TYPE:SUBSlice[:INTerval] <SubsliceInterva>

Defines the difference between the lowest data cell index allocated to a subslice and
the highest data cell index allocated to the immediately preceding subslice within a dis-
persed PLP.
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Parameters:
<SubsliceInterva> integer

Range: 0  to  16777215
*RST: 1

Example: See Example "Configure interleaving parameters" on page 84.

Manual operation: See "Subslice Interval" on page 28

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:TIL <TimeInterMode>

Sets the time interleaver mode.

Parameters:
<TimeInterMode> OFF | CTI | HTI

*RST: CTI

Example: See Example "Configure interleaving parameters" on page 84.

Manual operation: See "Time Interleaver Mode" on page 28

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:NTIBlocks <NumberTIBlocks>

Defines the number of time interleaver blocks or the number of subframes.

The behavior depends on the setting of [:SOURce<hw>]:BB:A3TSc:PLP<ch>:
TIL:INTer? on page 87:
● If enabled, defines the number of subframes over which cells from one time inter-

leaver (TI) block are carried.
● If disabled, defines the number of time interleaver blocks.

Parameters:
<NumberTIBlocks> integer

Range: 1  to  16
*RST: 1

Example: See Example "Configure interleaving parameters" on page 84.

Manual operation: See "Number of TI Blocks" on page 29

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:DEPTh <Depth>

Defines the time interleaving depths.

Parameters:
<Depth> D512 | D724 | D887 | D1024 | D1254 | D1448

D1448|D1254
Require extended interleaving, e.g. for PLP 1:
SOURce1:BB:A3TSc:PLP1:TIL:EXTended ON
*RST: D1024

Example: See Example "Configure interleaving parameters" on page 84.
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Manual operation: See "Depth" on page 28

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:EXTended <ExtendedInter>

If enabled, increases the time interleaving depth.

Parameters:
<ExtendedInter> 0 | 1 | OFF | ON

Example: See Example "Configure interleaving parameters" on page 84.

Manual operation: See "Extended Interleaving" on page 28

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:INTer?

Defines the interleaving frame content and mapping.

Return values: 
<InterSubframe> 0 | 1 | OFF | ON

ON
Each interleaving frame contains one time interleaver block and
is mapped to multiple subframes.
OFF
Each interleaving frame is mapped directly to one subframe, and
the interleaving frame is composed of one or more time interlea-
ver blocks.

Example: See Example "Configure interleaving parameters" on page 84.

Usage: Query only

Manual operation: See "Inter Subframe" on page 28

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:BLOCks?

Queries the number of FEC blocks contained in the current interleaving frame.

Return values: 
<NumberFECBlocks> string

Example: See Example "Configure interleaving parameters" on page 84.

Usage: Query only

Manual operation: See "Number of FEC Blocks" on page 29

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:MAXBlocks?

Queries the maximum number of FEC blocks per interleaving frame.
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Return values: 
<FECBlocksMax> integer

Range: 1  to  4096
*RST: 1

Example: See Example "Configure interleaving parameters" on page 84.

Usage: Query only

Manual operation: See "Max. Number of FEC Blocks" on page 29

[:SOURce<hw>]:BB:A3TSc:PLP<ch>:TIL:CIL <CellInterleaver>

Enables or disables the interleaver operating at the cell level.

Parameters:
<CellInterleaver> 0 | 1 | OFF | ON

Example: See Example "Configure interleaving parameters" on page 84.

Manual operation: See "Cell Interleaver" on page 29

4.5  OFDM and Subframe Commands

The section contains the commands for configuring OFDM symbols and subframing.

● General Commands................................................................................................88
● Symbol Commands.................................................................................................91
● Subframe Info Commands...................................................................................... 93

4.5.1  General Commands

Example: Configuring general OFDM and subframing parameters
:SOURce1:BB:A3TSc:FRAMe:NSUBframes?
// Response: 8
// The frame consists of 8 subframes.

:SOURce1:BB:A3TSc:CHANnel:BANDwidth BW_7
// Query the used bandwidth in MHz.
:SOURce1:BB:A3TSc:SUBFrame1:USED:BANDwidth?
// Response: 6804246.1
:SOURce1:BB:A3TSc:SUBFrame1:MIMO?
// Response: OFF
:SOURce1:BB:A3TSc:SUBFrame1:MISO C256
:SOURce1:BB:A3TSc:SUBFrame1:FFT:MODE M8K
:SOURce1:BB:A3TSc:SUBFrame1:GUARd:INTerval G192
:SOURce1:BB:A3TSc:SUBFrame1:NDATa 72
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[:SOURce<hw>]:BB:A3TSc:CHANnel[:BANDwidth] <ChannelBW>

Selects the channel bandwidth.

Parameters:
<ChannelBW> BW_6 | BW_7 | BW_8

*RST: BW_6

Example: See Example "Configuring general OFDM and subframing
parameters" on page 88.

Manual operation: See "Channel Bandwidth" on page 31

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:CARRier:MODE <RedCarrierMode>

Sets a coefficient for reducing the maximum number of carriers.

Parameters:
<RedCarrierMode> integer

Range: 0  to  4
*RST: 0

Example: See Example "Configuring general OFDM and subframing
parameters" on page 88.

Manual operation: See "Reduced Carrier Mode" on page 33

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:FFT:MODE <FFTMode>

Defines the FFT size.

Parameters:
<FFTMode> M16K | M8K | M32K | M8K | M16K | M32K

*RST: M8K

Example: See Example "Configuring general OFDM and subframing
parameters" on page 88.

Manual operation: See "FFT Size" on page 32

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:GUARd:INTerval <GuardInterval>

Sets the guard interval length.
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Parameters:
<GuardInterval> G192 | G384 | G512 | G768 | G1024 | G1536 | G2048 | G2432 |

G3072 | G3648 | G4096 | G4864
*RST: G192

Example: See Example "Configuring general OFDM and subframing
parameters" on page 88.

Manual operation: See "Guard Interval" on page 33

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:MIMO?

Displays whether multiple inputs and multiple outputs (MIMO) are used.

Return values: 
<MIMO> OFF | ON | 1 | 0 | 0 | 1 | OFF | ON

Example: See Example "Configuring general OFDM and subframing
parameters" on page 88.

Usage: Query only

Manual operation: See "MIMO" on page 32

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:MISO <MISO>

Defines the multiple inputs and single output (MISO) option.

Parameters:
<MISO> OFF | C64 | C256

Example: See Example "Configuring general OFDM and subframing
parameters" on page 88.

Manual operation: See "MISO" on page 32

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:NDATa <TotNumData>

Sets the number of data symbols per subframe, including the subframe boundary sym-
bols, excluding the preamble OFDM symbols.

Parameters:
<TotNumData> integer

Range: 1  to  2048
*RST: 72

Example: See Example "Configuring general OFDM and subframing
parameters" on page 88.

Manual operation: See "Total Number of Data OFDM Symbols" on page 33
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4.5.2  Symbol Commands

Example: Configuring OFDM symbol parameters per subframe
:SOURce1:BB:A3TSc:SUBFrame1:GUARd:INTerval G192

:SOURce1:BB:A3TSc:SUBFrame1:PILot:SISO SP32_2
:SOURce1:BB:A3TSc:SUBFrame1:PILot:BOOSt 4
:SOURce1:BB:A3TSc:SUBFrame1:SBS:FIRST 1
:SOURce1:BB:A3TSc:SUBFrame1:SBS:LAST?
// Response: 1
:SOURce1:BB:A3TSc:SUBFrame1:SBS:NULL?
// Response: 633
:SOURce1:BB:A3TSc:SUBFrame1:FIL ON

Commands

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PILot:SISO......................................................91
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PILot:BOOSt................................................... 91
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:FIL................................................................. 92
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:SBS:FIRSt...................................................... 92
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:SBS:LAST?.....................................................92
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:SBS:NULL?.....................................................92

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PILot:SISO <SISPPilotPat>

Sets the scattered pilot pattern for single input and single output (SISO).

Parameters:
<SISPPilotPat> SP32_4 | SP32_2 | SP24_4 | SP16_4 | SP3_2 | SP3_4 |

SP4_2 | SP4_4 | SP6_2 | SP6_4 | SP8_2 | SP8_4 | SP12_2 |
SP12_4 | SP16_2 | SP24_2 | SP3_2 | SP3_4 | SP4_2 | SP4_4 |
SP6_2 | SP6_4 | SP8_2 | SP8_4 | SP12_2 | SP12_4 | SP16_2 |
SP16_4 | SP24_2 | SP24_4 | SP32_2 | SP32_4
*RST: SP32_2

Example: See Example "Configuring OFDM symbol parameters per sub-
frame" on page 91.

Manual operation: See "SISO Pilot Pattern" on page 34

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PILot:BOOSt <PilotBoostMode>

Sets the power boost mode for the scattered pilots.

Parameters:
<PilotBoostMode> integer

Range: 0  to  4
*RST: 4

Example: See Example "Configuring OFDM symbol parameters per sub-
frame" on page 91.
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Manual operation: See "Pilot Boost Mode" on page 34

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:FIL <FreqInterleaver>

Enables/disables the frequency interleaver.

Parameters:
<FreqInterleaver> OFF | ON | 1 | 0 | 0 | 1 | OFF | ON

*RST: ON

Example: See Example "Configuring OFDM symbol parameters per sub-
frame" on page 91.

Manual operation: See "Frequency Interleaver" on page 35

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:SBS:FIRSt <SubfrFirst>

Defines whether the first symbol of a subframe is a subframe boundary symbol.

Parameters:
<SubfrFirst> integer

Range: 0  to  1
*RST: 0

Example: See Example "Configuring OFDM symbol parameters per sub-
frame" on page 91.

Manual operation: See "Subframe Boundary Symbol (First)" on page 34

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:SBS:LAST?

Queries whether the last symbol of a subframe is a subframe boundary symbol.

Return values: 
<SubfrLast> integer

Range: 0  to  1
*RST: 0

Example: See Example "Configuring OFDM symbol parameters per sub-
frame" on page 91.

Usage: Query only

Manual operation: See "Subframe Boundary Symbol (Last)" on page 35

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:SBS:NULL?

Queries the number of null cells in the subframe boundary symbols.
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Return values: 
<SubfrNullCells> integer

Range: 0  to  8191
*RST: 0

Example: See Example "Configuring OFDM symbol parameters per sub-
frame" on page 91.

Usage: Query only

Manual operation: See "Subframe Boundary Symbol (Null Cells)" on page 35

4.5.3  Subframe Info Commands

Example: Querying subframe information
// Query the subframe length in ms.
:SOURce1:BB:A3TSc:SUBFrame1:DURation?
// Response: 0.282666666666667

// Query the used bandwidth of the subframe in MHz.
:SOURce1:BB:A3TSc:SUBFrame1:USED:BANDwidth?
// Response: 5.832421
:SOURce1:BB:A3TSc:SUBFrame1:PLP:NPLP?
// Response: 2
:SOURce1:BB:A3TSc:SUBFrame1:PLP:NIDPlp?
// Response: "0,1"
// PLPs with IDs 0 to 1 are mapped to subframe 1.

Commands

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:DURation?...................................................... 93
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:USED[:BANDwidth]?........................................94
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PLP:NPLP?.....................................................94
[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PLP:NIDPlp?...................................................94

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:DURation?

Queries the duration of the subframe.

Return values: 
<Duration> float

Range: 0  to  9999.999
Increment: 0.001
*RST: 0

Example: See Example "Querying subframe information" on page 93.

Usage: Query only

Manual operation: See "Duration" on page 36
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[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:USED[:BANDwidth]?

Queries the used bandwidth per subframe.

Return values: 
<UsedBW> integer

Range: 0  to  9.9999999
*RST: 0

Example: See Example "Querying subframe information" on page 93.

Usage: Query only

Manual operation: See "Used Bandwidth" on page 36

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PLP:NPLP?

Queries the number of PLPs in the subframe.

Return values: 
<NumPLPsSubfr> integer

Range: 1  to  64
*RST: 1

Example: See Example "Querying subframe information" on page 93.

Usage: Query only

Manual operation: See "Number of PLPs in Subframe" on page 36

[:SOURce<hw>]:BB:A3TSc:SUBFrame<ch>:PLP:NIDPlp?

Queries all IDs of the PLPs mapped to the subframe.

Return values: 
<PLPIDsSubfr> string

Example: See Example "Querying subframe information" on page 93.

Usage: Query only

Manual operation: See "PLP IDs in Subframe" on page 36

4.6  System Commands

The section contains the commands for configuring the ATSC 3.0 system.

● Network Commands................................................................................................95
● Frame Commands.................................................................................................. 98
● L1 Commands.......................................................................................................101
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4.6.1  Network Commands

Example: Configuring network parameters
//******************************************************************************
// Configure multi frequency network properties.
//******************************************************************************
:SOURce1:BB:A3TSc:NETWorkmode MFN

:SOURce1:BB:A3TSc:TIME MSEC
:SOURce1:BB:A3TSc:LLS?
// Response: ABSent
:SOURce1:BB:A3TSc:RETurn:CHANnel?
// Response: ABSent
:SOURce1:BB:A3TSc:MISO:NTX 4
:SOURce1:BB:A3TSc:MISO:IDX 4
:SOURce1:BB:A3TSc:TXId:MODE MAN
:SOURce1:BB:A3TSc:TXId:ADDRess 8191
:SOURce1:BB:A3TSc:TXId:LEVel L450
:SOURce1:BB:A3TSc:L:DETail:VERSion?
// Response: 0
:SOURce1:BB:A3TSc:L:DETail:VERSion 1
// You can set the broadcast stream ID
:SOURce1:BB:A3TSc:BSID 1234

//******************************************************************************
// Configure single frequency network (SFN) properties.
//******************************************************************************
:SOURce1:BB:A3TSc:INPut:STL:INTerface ON
// SFN is only possible in STL operation mode.
:SOURce1:BB:A3TSc:NETWorkmode SFN

:SOURce1:BB:A3TSc:TIME?
// Response: OFF
:SOURce1:BB:A3TSc:LLS?
// Response: ABSent
:SOURce1:BB:A3TSc:RETurn:CHANnel?
// Response: ABSent
:SOURce1:BB:A3TSc:MISO:NTX 4
:SOURce1:BB:A3TSc:MISO:IDX 4
:SOURce1:BB:A3TSc:TXId:MODE MAN
:SOURce1:BB:A3TSc:TXId:ADDRess 8191
:SOURce1:BB:A3TSc:TXId:LEVel L450

For single frequency network delays and mode commands, see Chapter 4.8, "SFN
Delay Commands", on page 111.
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Commands

[:SOURce<hw>]:BB:A3TSc:NETWorkmode........................................................................ 96
[:SOURce<hw>]:BB:A3TSc:BSID.......................................................................................96
[:SOURce<hw>]:BB:A3TSc:LLS?.......................................................................................96
[:SOURce<hw>]:BB:A3TSc:MISo:NTX............................................................................... 96
[:SOURce<hw>]:BB:A3TSc:MISo:IDX................................................................................ 97
[:SOURce<hw>]:BB:A3TSc:RETurn[:CHANnel]?................................................................. 97
[:SOURce<hw>]:BB:A3TSc:TIME...................................................................................... 97
[:SOURce<hw>]:BB:A3TSc:TXId:MODE.............................................................................97
[:SOURce<hw>]:BB:A3TSc:TXId:ADDRess........................................................................ 98
[:SOURce<hw>]:BB:A3TSc:TXId:LEVel..............................................................................98

[:SOURce<hw>]:BB:A3TSc:NETWorkmode <NetworkMode>

Sets the network mode.

Parameters:
<NetworkMode> MFN | SFN

Example: See Example "Configuring network parameters" on page 95.

Manual operation: See "Network Mode" on page 38

[:SOURce<hw>]:BB:A3TSc:BSID <BroadcastStrID>

Sets the ID of the broadcast stream.

Parameters:
<BroadcastStrID> integer

Range: 0  to  65535
*RST: 0

Example: See Example "Configuring network parameters" on page 95.

Manual operation: See "Broadcast Stream ID (BSID)" on page 40

[:SOURce<hw>]:BB:A3TSc:LLS?

Queries, if low-level signaling is present or absent.

Return values: 
<LowLevelSign> ABSent | PRESent

Example: See Example "Configuring network parameters" on page 95.

Usage: Query only

Manual operation: See "Low Level Signaling (LLS)" on page 39

[:SOURce<hw>]:BB:A3TSc:MISo:NTX <NumTransmitters>

Sets the number of transmitters for MISO transmission.
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Parameters:
<NumTransmitters> integer

Range: 2  to  4
*RST: 2

Example: See Example "Configuring network parameters" on page 95.

Manual operation: See "Number of Transmitters (N_TX)" on page 40

[:SOURce<hw>]:BB:A3TSc:MISo:IDX <TransmitterIdx>

Sets the transmitter index for MISO transmission.

Parameters:
<TransmitterIdx> integer

Range: 1  to  4
*RST: 1

Example: See Example "Configuring network parameters" on page 95.

Manual operation: See "Transmitter Index (x)" on page 40

[:SOURce<hw>]:BB:A3TSc:RETurn[:CHANnel]?

Queries, if a dedicated return channel (DRC) is present or absent.

Return values: 
<ReturnChannel> ABSent | PRESent

Example: See Example "Configuring network parameters" on page 95.

Usage: Query only

Manual operation: See "Return Channel" on page 39

[:SOURce<hw>]:BB:A3TSc:TIME <TimeInfo>

Configures the time information.

Parameters:
<TimeInfo> MSEC | USEC | NSEC | OFF

*RST: OFF

Example: See Example "Configuring network parameters" on page 95.

Manual operation: See "Time Info" on page 39

[:SOURce<hw>]:BB:A3TSc:TXId:MODE <TxIDMode>

Sets the Tx ID mode.

The mode affects the setting of the "TxID Address" and "TxID Injection Level".
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Parameters:
<TxIDMode> MANual | AUTo | OFF

*RST: OFF

Example: See Example "Configuring network parameters" on page 95.

Manual operation: See "TxID Mode" on page 40

[:SOURce<hw>]:BB:A3TSc:TXId:ADDRess <TxIDAdress>

Sets the transmitter identification address.

Parameters:
<TxIDAdress> integer

Range: 0  to  8191
*RST: 0

Example: See Example "Configuring network parameters" on page 95.

Manual operation: See "TxID Address" on page 40

[:SOURce<hw>]:BB:A3TSc:TXId:LEVel <TxIDInjLevel>

Sets the injection levels for injecting a TxID signal into the host preamble.

Parameters:
<TxIDInjLevel> OFF | L450 | L420 | L390 | L360 | L330 | L300 | L270 | L240 |

L210 | L180 | L150 | L120 | L90
Level L<x> with <x> meaning the level in dB

*RST: OFF

Example: L270 means 27.0 dB

Example: See Example "Configuring network parameters" on page 95.

Manual operation: See "TxID Injection Level" on page 40

4.6.2  Frame Commands

Example: Configuring frame parameters
:SOURce1:BB:A3TSc:FRAMe:NSUBframes?
// Response: 1
// 1 subframe per frame

:SOURce1:BB:A3TSc:PAPR TR

:SOURce1:BB:A3TSc:FRAMe:MODE SYMB
:SOURce1:BB:A3TSc:FRAMe:TIME:OFFset?
// Response: 4608
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:SOURce1:BB:A3TSc:FRAMe:ADDitional:SAMPles?
// Response: 0

:SOURce1:BB:A3TSc:FRAMe:MODE TIME
// Set the frame length in ms.
:SOURce1:BB:A3TSc:FRAMe:LENGth 150
:SOURce1:BB:A3TSc:FRAMe:EXSYmbol?
// Response: 4736
:SOURce1:BB:A3TSc:FRAMe:EXFinal?
// Response: 0

Commands

[:SOURce<hw>]:BB:A3TSc:PAPR......................................................................................99
[:SOURce<hw>]:BB:A3TSc:FRAMe:NSUBframes?..............................................................99
[:SOURce<hw>]:BB:A3TSc:FRAMe:MODE.......................................................................100
[:SOURce<hw>]:BB:A3TSc:FRAMe:LENGth.....................................................................100
[:SOURce<hw>]:BB:A3TSc:FRAMe:EXSYmbol?...............................................................100
[:SOURce<hw>]:BB:A3TSc:FRAMe:EXFinal?................................................................... 100
[:SOURce<hw>]:BB:A3TSc:FRAMe:TIME[:OFFSet]?.........................................................101
[:SOURce<hw>]:BB:A3TSc:FRAMe:ADDitional[:SAMPles]?............................................... 101

[:SOURce<hw>]:BB:A3TSc:PAPR <PAPR>

Sets the technique to reduce the peak to average power ratio.

Parameters:
<PAPR> OFF | TR

Example: See Example "Configuring frame parameters" on page 98.

Manual operation: See "Peak To Average Power Ratio" on page 41

[:SOURce<hw>]:BB:A3TSc:FRAMe:NSUBframes?

Queries the number of subframes.

Return values: 
<NumSubframes> integer

Range: 1  to  256
*RST: 1

Example: See:
Example "Configuring general OFDM and subframing parame-
ters" on page 88
Example "Configuring frame parameters" on page 98

Usage: Query only

Manual operation: See "Number of Subframes" on page 31
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[:SOURce<hw>]:BB:A3TSc:FRAMe:MODE <FrameMode>

Sets how the frame length is aligned.

Parameters:
<FrameMode> TIME | SYMBol

*RST: SYMBol

Example: See Example "Configuring frame parameters" on page 98.

Manual operation: See "Frame Mode" on page 42

[:SOURce<hw>]:BB:A3TSc:FRAMe:LENGth <FrameLength>

Sets the time period measured from the beginning of the first sample of the bootstrap
to the end of the final sample of the frame.

Parameters:
<FrameLength> integer

Range: 50  to  5000
Increment: 5
*RST: 50

Example: See Example "Configuring frame parameters" on page 98.

Manual operation: See "Frame Length" on page 42

[:SOURce<hw>]:BB:A3TSc:FRAMe:EXSYmbol?

Queries the additional number of excess samples included in the guard interval of each
non-preamble OFDM symbol of the post-bootstrap portion.

Return values: 
<ExcessSymbol> integer

Range: 0  to  8191
*RST: 0

Example: See Example "Configuring frame parameters" on page 98.

Usage: Query only

Manual operation: See "Excess Samples per Symbol" on page 42

[:SOURce<hw>]:BB:A3TSc:FRAMe:EXFinal?

Queries the excess samples that are inserted immediately following the final OFDM
symbol of the final subframe.

Return values: 
<FinalExcSamples> integer

Range: 0  to  32767
*RST: 0

Example: See Example "Configuring frame parameters" on page 98.
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Usage: Query only

Manual operation: See "Final Excess Samples" on page 42

[:SOURce<hw>]:BB:A3TSc:FRAMe:TIME[:OFFSet]?

Queries the number of sample periods between the nearest preceding or coincident
millisecond boundary and the leading edge of the frame.

Return values: 
<TimeOffset> integer

Range: 0  to  65535
*RST: 0

Example: See Example "Configuring frame parameters" on page 98.

Usage: Query only

Manual operation: See "Time Offset" on page 42

[:SOURce<hw>]:BB:A3TSc:FRAMe:ADDitional[:SAMPles]?

Queries the number of additional samples added at the end of a frame to facilitate
sampling clock alignment.

Return values: 
<AddSamples> integer

Range: 0  to  127
*RST: 0

Example: See Example "Configuring frame parameters" on page 98.

Usage: Query only

Manual operation: See "Additional Samples" on page 42

4.6.3  L1 Commands

Example: Configuring L1 parameters
// Editing some L1 parameters requires disabling STL interface.
:SOURce1:BB:A3TSc:INPut:STL:INTerface 0

:SOURce1:BB:A3TSc:L:BASic:VERSion?
// Response: 0
:SOURce1:BB:A3TSc:L:NPReamble:SYMBols?
// Response: 1
:SOURce1:BB:A3TSc:L:BASic:FECType MOD1
:SOURce1:BB:A3TSc:L:CARRier:MODE 0
:SOURce1:BB:A3TSc:L:PILot:DX D16
:SOURce1:BB:A3TSc:L:DETail:VERSion 0
:SOURce1:BB:A3TSc:L:DETail:FECType MOD1
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:SOURce1:BB:A3TSc:L:DETail:ADDitional:PARity?
// Response: OFF
:SOURce1:BB:A3TSc:NRF?
// Response: 0

Commands

[:SOURce<hw>]:BB:A3TSc:L:BASic:FECType.................................................................. 102
[:SOURce<hw>]:BB:A3TSc:L:BASic:VERSion?.................................................................102
[:SOURce<hw>]:BB:A3TSc:L:CARRier:MODE.................................................................. 102
[:SOURce<hw>]:BB:A3TSc:L:DETail:ADDitional[:PARity]?..................................................103
[:SOURce<hw>]:BB:A3TSc:L:DETail:FECType..................................................................103
[:SOURce<hw>]:BB:A3TSc:L:DETail:VERSion.................................................................. 103
[:SOURce<hw>]:BB:A3TSc:L:NPReamble[:SYMBols]?...................................................... 103
[:SOURce<hw>]:BB:A3TSc:L:PILot:DX............................................................................ 104
[:SOURce<hw>]:BB:A3TSc:NRF?....................................................................................104

[:SOURce<hw>]:BB:A3TSc:L:BASic:FECType <L1BasicFECType>

Defines the protection level of L1 basic signaling.

Parameters:
<L1BasicFECType> MOD1 | MOD2 | MOD3 | MOD4 | MOD5

*RST: MOD1

Example: See Example "Configuring L1 parameters" on page 101.

Manual operation: See "L1 Basic FEC Type" on page 43

[:SOURce<hw>]:BB:A3TSc:L:BASic:VERSion?

Queries the version of the L1 basic signaling structure that is used for the current
frame.

Return values: 
<L1BasicVersion> integer

Range: 0  to  7
*RST: 0

Example: See Example "Configuring L1 parameters" on page 101.

Usage: Query only

Manual operation: See "L1 Basic Version" on page 43

[:SOURce<hw>]:BB:A3TSc:L:CARRier:MODE <RedCarrModePre>

Sets a coefficient for reducing the maximum number of carriers.

Parameters:
<RedCarrModePre> integer

Range: 0  to  4
*RST: 0
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Example: See Example "Configuring L1 parameters" on page 101.

Manual operation: See "Reduced Carrier Mode Preamble" on page 44

[:SOURce<hw>]:BB:A3TSc:L:DETail:ADDitional[:PARity]?

Queries the L1 detail additional parity mode, that is disabled by default.

Return values: 
<L1DetailAddPar> OFF | K1 | K2

Example: See Example "Configuring L1 parameters" on page 101.

Usage: Query only

Manual operation: See "L1 Detail Additional Parity Mode" on page 44

[:SOURce<hw>]:BB:A3TSc:L:DETail:FECType <L1DetailFECType>

Defines the protection level of L1 detail signaling.

Parameters:
<L1DetailFECType> MOD1 | MOD2 | MOD3 | MOD4 | MOD5 | MOD6 | MOD7

*RST: MOD1

Example: See Example "Configuring L1 parameters" on page 101.

Manual operation: See "L1 Detail FEC Type" on page 44

[:SOURce<hw>]:BB:A3TSc:L:DETail:VERSion <L1DetailVers>

Sets the version of the L1 detail signaling structure that is used for the current frame.

Parameters:
<L1DetailVers> integer

Range: 0  to  15
*RST: 0

Example: See Example "Configuring L1 parameters" on page 101.

Manual operation: See "L1 Detail Version" on page 44

[:SOURce<hw>]:BB:A3TSc:L:NPReamble[:SYMBols]?

Queries the total number of OFDM symbols contained in the preamble.

Return values: 
<NumPreSymb> integer

Range: 1  to  8
*RST: 1

Example: See Example "Configuring L1 parameters" on page 101.

Usage: Query only
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Manual operation: See "Number of Preamble Symbols" on page 44

[:SOURce<hw>]:BB:A3TSc:L:PILot:DX <PilotPatPre>

Sets the pilot pattern used for the preamble symbols.

Parameters:
<PilotPatPre> D3 | D4 | D6 | D8 | D12 | D16 | D24 | D32

*RST: D16

Example: See Example "Configuring L1 parameters" on page 101.

Manual operation: See "Pilot Pattern (Dx) Preamble" on page 44

[:SOURce<hw>]:BB:A3TSc:NRF?

Queries the number of radio frequencies involved in channel bonding.

Return values: 
<NumRFs> integer

0
Channel bonding is not used for the current frame.
Range: 0  to  1
*RST: 0

Example: See Example "Configuring L1 parameters" on page 101.

Usage: Query only

Manual operation: See "Number of RFs" on page 45

4.7  Frame Info Commands

The section contains the commands for querying frame and bootstrap information.

● General Commands..............................................................................................104
● L1 Signaling Commands.......................................................................................105
● Bootstrap Commands........................................................................................... 107

4.7.1  General Commands

Example: Querying general frame information
:SOURce1:BB:A3TSc:INFO:FRAMe:DURation?
// Response: 0.179093 s
:SOURce1:BB:A3TSc:INFO:BOOTstrap:DURation?
// Response: 0.002 s

Frame Info Commands



Remote-Control CommandsR&S®SMCVB-K162

105User Manual 1179.0980.02 ─ 03

Commands

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:DURation?...................................................105
[:SOURce<hw>]:BB:A3TSc:INFO:FRAMe:DURation?........................................................105

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:DURation?

Queries the duration of the bootstrap signal in ms.

Return values: 
<Duration> float

Range: 2.000  to  2.000
Increment: 0.001
*RST: 2.000

Example: See Example "Querying general frame information"
on page 104.

Usage: Query only

Manual operation: See "Bootstrap Duration" on page 46

[:SOURce<hw>]:BB:A3TSc:INFO:FRAMe:DURation?

Queries the frame duration in ms.

Return values: 
<Duration> float

Range: 0  to  9999.999
Increment: 0.001
*RST: 0

Example: See Example "Querying general frame information"
on page 104.

Usage: Query only

Manual operation: See "Frame Duration" on page 46

4.7.2  L1 Signaling Commands

Example: Querying L1 signaling parameters
:SOURce1:BB:A3TSc:INFO:L:BASic:BYTes?
// Response: 25
:SOURce1:BB:A3TSc:INFO:L:BASic:CELLs?
// Response: 3820
:SOURce1:BB:A3TSc:INFO:L:DETail:BYTes?
// Response: 25
:SOURce1:BB:A3TSc:INFO:L:DETail:CELLs?
// Response: 2787
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Commands

[:SOURce<hw>]:BB:A3TSc:INFO:L:BASic:BYTes?............................................................106
[:SOURce<hw>]:BB:A3TSc:INFO:L:BASic:CELLs?............................................................106
[:SOURce<hw>]:BB:A3TSc:INFO:L:DETail:BYTes?........................................................... 106
[:SOURce<hw>]:BB:A3TSc:INFO:L:DETail:CELLs?...........................................................107

[:SOURce<hw>]:BB:A3TSc:INFO:L:BASic:BYTes?

Queries the L1 basic signaling length in bytes.

Return values: 
<BasicBytes> integer

Range: 25  to  25
*RST: 25

Example: See Example "Querying L1 signaling parameters" on page 105.

Usage: Query only

Manual operation: See "L1 Basic Bytes" on page 46

[:SOURce<hw>]:BB:A3TSc:INFO:L:BASic:CELLs?

Queries the L1 basic signaling length in cells.

Return values: 
<BasicCells> integer

Range: 69  to  3820
*RST: 69

Example: See Example "Querying L1 signaling parameters" on page 105.

Usage: Query only

Manual operation: See "L1 Basic Cells" on page 47

[:SOURce<hw>]:BB:A3TSc:INFO:L:DETail:BYTes?

Queries the L1 detail signaling length in bytes.

Return values: 
<DetailedBytes> integer

Range: 25  to  8191
*RST: 25

Example: See Example "Querying L1 signaling parameters" on page 105.

Usage: Query only

Manual operation: See "L1 Detail Bytes" on page 46
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[:SOURce<hw>]:BB:A3TSc:INFO:L:DETail:CELLs?

Queries the L1 detail signaling length in cells.

Return values: 
<DetailCells> integer

Range: 0  to  5242887
*RST: 0

Example: See Example "Querying L1 signaling parameters" on page 105.

Usage: Query only

Manual operation: See "L1 Detail Cells" on page 47

4.7.3  Bootstrap Commands

Example: Querying bootstrap parameters
// Query major and minor version.
:SOURce1:BB:A3TSc:INFO:BOOTstrap:MAJor?
// Response: 0
:SOURce1:BB:A3TSc:INFO:BOOTstrap:MINor?
// Response: 0
:SOURce1:BB:A3TSc:INFO:BOOTstrap:TIME:NEXT?
// Response: N150
// Minimum time interval to the next frame is 150 ms.
:SOURce1:BB:A3TSc:INFO:BOOTstrap:EAS?
// Response: NOEMergency
:SOURce1:BB:A3TSc:INFO:BOOTstrap:BANDwidth?
// Response: BW_6
:SOURce1:BB:A3TSc:INFO:BOOTstrap:BSR:COEFficient?
// Response: 2

:SOURce1:BB:A3TSc:INFO:BOOTstrap:PREamble:STRucture?
// Response: 40
:SOURce1:BB:A3TSc:INFO:BOOTstrap:FFT:MODE?
// Response: M8K
:SOURce1:BB:A3TSc:INFO:BOOTstrap:PILot:DX?
// Response: D3
:SOURce1:BB:A3TSc:INFO:BOOTstrap:GUARd:INTerval?
// Response: G192
:SOURce1:BB:A3TSc:INFO:BOOTstrap:BASic:FECType?
// Response: MOD1

Commands

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:BANDwidth?................................................ 108
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:BASic:FECType?..........................................108
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[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:FFT:MODE?.................................................109
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:GUARd:INTerval?.........................................109
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:MAJor?....................................................... 109
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:MINor?........................................................109
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:PILot:DX?.................................................... 110
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:PREamble[:STRucture]?............................... 110
[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:TIME:NEXT?................................................110

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:BANDwidth?

Queries the system bandwidth used for the post-bootstrap portion of the current physi-
cal layer frame.

Return values: 
<FrameInfoBW> BW_6 | BW_7 | BW_8 | BW8G

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "System Bandwidth" on page 48

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:BASic:FECType?

Queries the FEC type used for the L1 basic signaling in the preamble symbol.

Return values: 
<L1BasicFECType> MOD1 | MOD2 | MOD3 | MOD4 | MOD5 | MOD6 | MOD7

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "L1 Basic FEC Type" on page 50

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:BSR:COEFficient?

Queries the sample rate used for the post-bootstrap portion of the current physical
layer frame.

Return values: 
<BSRCoefficient> integer

Range: 0  to  127
*RST: 2

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "BSR Coefficient" on page 48

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:EAS?

Queries the signaling mode for emergency alert.
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Return values: 
<EAS> NOEMergency | SET1 | SET2 | SET3

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "Emergency Alert Signaling (EAS)" on page 48

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:FFT:MODE?

Queries the FFT size of the preamble symbols.

Return values: 
<FFTMode> M8K | M16K | M32K

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "FFT Size" on page 49

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:GUARd:INTerval?

Queries the number of guard interval samples of the preamble symbols.

Return values: 
<GuardInterval> G192 | G384 | G512 | G768 | G1024 | G1536 | G2048 | G2432 |

G3072 | G3648 | G4096 | G4864

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "Guard Interval" on page 49

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:MAJor?

Queries the major version of the bootstrap.

Return values: 
<Major> integer

Range: 0  to  0
*RST: 0

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "Major Version" on page 47

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:MINor?

Queries the minor version of the bootstrap.
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Return values: 
<Minor> integer

Range: 0  to  7
*RST: 0

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "Minor Version" on page 47

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:PILot:DX?

Queries the pilot pattern used for the preamble symbols.

Return values: 
<PilotPattern> D3 | D4 | D6 | D8 | D12 | D16 | D24 | D32

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "Pilot Pattern (Dx)" on page 50

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:PREamble[:STRucture]?

Queries the structure of the preamble symbols following the last bootstrap symbol.

Return values: 
<PreStructure> integer

Range: 0  to  255
*RST: 0

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only

Manual operation: See "Preamble Structure" on page 49

[:SOURce<hw>]:BB:A3TSc:INFO:BOOTstrap:TIME:NEXT?

Queries minimum time interval to the next frame that matches the same major and
minor version number of the current frame.

Return values: 
<MinTimetoNext> N50 | N100 | N150 | N200 | N250 | N300 | N350 | N400 | N500 |

N600 | N700 | N800 | N900 | N1000 | N1100 | N1200 | N1300 |
N1400 | N1500 | N1600 | N1700 | N1900 | N2100 | N2300 |
N2500 | N2700 | N2900 | N3300 | N3700 | N4100 | N4500 |
N4900 | N5300 | NOTapplicable

Example: See Example "Querying bootstrap parameters" on page 107.

Usage: Query only
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Manual operation: See "Min. Time to Next" on page 48

4.8  SFN Delay Commands

The section contains the commands for configuring single frequency network delays.

Example: Configuring single frequency network delay parameters
//********************************************************************************
// Activate SFN network mode.
//********************************************************************************
:SOURce1:BB:A3TSc:INPut:STL:INTerface ON

// Query the SFN mode.
:SOURce1:BB:A3TSc:DELay:SFNMode?
// Response: RELative

// Query the network delay in s.
:SOURce1:BB:A3TSc:DELay:NETwork?
// Response: 0.149506

:SOURce1:BB:A3TSc:NETWorkmode SFN
// Query the processing delay in s.
:SOURce1:BB:A3TSc:DELay:PROCess?
// Response: 0.100187

// Query the dynamic delay in s.
:SOURce1:BB:A3TSc:DELay:DYNamic?
// Response: 0.350307

// Query the total delay in s, that is the sum of processing and dynamic delay.
:SOURce1:BB:A3TSc:DELay:TOTal?
// Response: 0.450494

// Set a maximum permissible delay of, e.g., 10 μs.
:SOURce1:BB:A3TSc:DELay:DEViation 0.000010

// Set a static delay of, e.g., -10 μs.
:SOURce1:BB:A3TSc:DELay:STATic -0.000010
// The start of transmission is shifted to 10 μs earlier.

// Query the maximum delay in s.
:SOURce1:BB:A3TSc:DELay:MAXimum?
// Response: 2.6

// Query the dispatch time in s, that is the sum of maximum and static delay.
:SOURce1:BB:A3TSc:DELay:DISPatch?
// Response: 2.59999
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// Replace the bootstrap signal by a null signal (no output power).
:SOURce1:BB:A3TSc:DELay:MUTE:BOOTstrap ON

Commands
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[:SOURce<hw>]:BB:A3TSc:DELay:DISPatch?.................................................................. 112
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[:SOURce<hw>]:BB:A3TSc:DELay:DEViation <Deviation>

Sets the maximum permissible delay.

Parameters:
<Deviation> float

Range: 1.0  to  500.0
Increment: 0.1
*RST: 10
Default unit: µs

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Manual operation: See "Max. Deviation Time" on page 52

[:SOURce<hw>]:BB:A3TSc:DELay:DISPatch?

Queries the time taken for the signal to travel from the playout center to the transmitter
antenna for real transmission.

Return values: 
<Dispatch> float

Range: -1000000.0  to  6000000.0
Increment: 0.1
*RST: 0
Default unit: µs

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Usage: Query only

Manual operation: See "Dispatch Time" on page 52
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[:SOURce<hw>]:BB:A3TSc:DELay:DYNamic?

Queries the transmission delay currently generated by the SFN delay (FIFO).

Return values: 
<Dynamic> float

Range: -16000000.0  to  6000000.0
Increment: 0.1
*RST: 0
Default unit: µs

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Usage: Query only

Manual operation: See "Dynamic Delay" on page 52

[:SOURce<hw>]:BB:A3TSc:DELay:MAXImum?

Queries the time taken for the signal to travel from the playout center to the transmitter
antenna for regular transmission.

Return values: 
<MaximumDelay> float

Range: 0.0  to  5000000.0
Increment: 0.1
*RST: 0
Default unit: µs

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Usage: Query only

Manual operation: See "Maximum Delay" on page 52

[:SOURce<hw>]:BB:A3TSc:DELay:MUTE[:BOOTstrap] <MuteBootstrap>

If enabled, replaces the bootstrap by a null signal (no output power).

Parameters:
<MuteBootstrap> 0 | 1 | OFF | ON

*RST: Off

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Manual operation: See "Mute Bootstrap of Frame" on page 52
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[:SOURce<hw>]:BB:A3TSc:DELay:NETWork?

Queries the time taken for the signal to travel from the playout center to the input of the
signal processing.

Return values: 
<Network> float

Range: 0.0  to  5000000.0
Increment: 0.1
*RST: 0
Default unit: µs

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Usage: Query only

Manual operation: See "Network Delay" on page 51

[:SOURce<hw>]:BB:A3TSc:DELay:PROCess?

Queries the delay from the modulator input up to the SFN delay (FIFO).

Return values: 
<Process> float

Range: 0.0  to  10000000.0
Increment: 0.1
*RST: 0
Default unit: µs

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Usage: Query only

Manual operation: See "Processing Delay" on page 51

[:SOURce<hw>]:BB:A3TSc:DELay:SFNMode <SFNMode>

Sets the SFN timestamp operation mode, that is fixed to relative timestamp mode.

Parameters:
<SFNMode> ABSolute | RELative

*RST: RELative

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Manual operation: See "SFN Mode" on page 53

[:SOURce<hw>]:BB:A3TSc:DELay:STATic <Static>

Sets the delay to shift the time of transmission positively or negatively.
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Parameters:
<Static> float

Range: -1000000.0  to  1000000.0
Increment: 0.1
*RST: 0
Default unit: µs

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Manual operation: See "Static Delay" on page 52

[:SOURce<hw>]:BB:A3TSc:DELay:TOTal?

Queries the sum of processing delay and dynamic delay.

Return values: 
<TotalDelay> float

Range: -6000000.0  to  6000000.0
Increment: 0.1
*RST: 0
Default unit: µs

Example: See Example "Configuring single frequency network delay
parameters" on page 111.

Usage: Query only

Manual operation: See "Total Delay" on page 52

4.9  Special Commands

The section contains commands to configure settings, that deviate from the broadcast
standard specification.

Example: Configuring special settings
SOURce1:BB:A3TSc:SPECial:SETTings:STATe?
// Response: 0
// Special settings are disabled to conform with the broadcast standard.

// Enable special settings to test deviations from the standard.

//******************************************************************************
// Special settings, if STL Interface is turned on.
//******************************************************************************
// Settings for STL interface compatibility modes.
:SOURce1:BB:A3TSc:SPECial:STL:PREamble ON
:SOURce1:BB:A3TSc:SPECial:STL:TMP ON
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//******************************************************************************
// Special settings, if STL Interface is turned off.
//******************************************************************************
// For ALP encapsulation compatibility modes.
:SOURce1:BB:A3TSc:SPECial:ALP:LMT ON
// For special bootstrap settings.
:SOURce1:BB:A3TSc:SPECial:BOOTstrap:MINor 7
:SOURce1:BB:A3TSc:SPECial:BOOTstrap:EAS SET3

// Apply special settings.
:SOURce1:BB:A3TSc:SPECial:SETTings:STATe ON
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[:SOURce<hw>]:BB:A3TSc:SPECial:SETTings[:STATe] <SpecialSettings>

Enables/disables special settings.

The setting allows you to switch between standard-compliant and user-defined channel
coding.

Parameters:
<SpecialSettings> 0 | 1 | OFF | ON

Example: See Example "Configuring special settings" on page 115.

Manual operation: See " Special Settings " on page 54

[:SOURce<hw>]:BB:A3TSc:SPECial:ALP:LMT <LMTCompMode>

Sets how the LMT signaling is supported.

Parameters:
<LMTCompMode> 0 | 1 | OFF | ON

Example: See Example "Configuring special settings" on page 115.

Manual operation: See "LMT Compatibility Mode" on page 55

[:SOURce<hw>]:BB:A3TSc:SPECial:BOOTstrap:EAS <EAS>

Sets the signaling for emergency alert.

Parameters:
<EAS> SET3 | SET2 | NOEMergency | SET1 | NOEMergency | SET1 |

SET2 | SET3
*RST: NOEMergency
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Example: See Example "Configuring special settings" on page 115.

Manual operation: See "Emergency Alert Signaling (EAS)" on page 55

[:SOURce<hw>]:BB:A3TSc:SPECial:BOOTstrap:MINor <MinoVers>

Sets the minor version number of the bootstrap.

Parameters:
<MinoVers> integer

Range: 0  to  7
*RST: 0

Example: See Example "Configuring special settings" on page 115.

Manual operation: See "Minor Version" on page 55

[:SOURce<hw>]:BB:A3TSc:SPECial:STL:PREamble <PreCompMode>

Sets how the preamble packet is supported.

Parameters:
<PreCompMode> 0 | 1 | OFF | ON

Example: See Example "Configuring special settings" on page 115.

Manual operation: See "Preamble Compatibility Mode" on page 55

[:SOURce<hw>]:BB:A3TSc:SPECial:STL:TMP <TMPCompMode>

Sets how the time & management packet is supported.

Parameters:
<TMPCompMode> 0 | 1 | OFF | ON

Example: See Example "Configuring special settings" on page 115.

Manual operation: See "TMP Compatibility Mode" on page 55

4.10  TSGen Subsystem

The TSGen subsystem contains the commands for configuring the TS player.

Example: Play a TS player file
//*********************************************************************************
// Select a file, e.g. a user-defined setting.
//*********************************************************************************
:TSGen:CONFigure:PLAYfile "/var/user/my_test_player_test.trp"
// Selects the file "my_test_player_test" with extension *.trp.
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//*********************************************************************************
// Within the file, define a section, that you want to play.
// You can set start/stop position for a maximum section length of 10 hours.
//*********************************************************************************
:TSGen:CONFigure:SEEK:STARt 60000 // milliseconds
// Section start is after one minute from the original file start.
// The first minute is ignored.
:TSGen:CONFigure:SEEK:STOP 120000 // milliseconds
// Section stop is after one minute from the original file start.
// The total section length is one minute.

//*********************************************************************************
// Navigate to a certain position within the file/section of the file.
//*********************************************************************************
:TSGen:CONFigure:SEEK:POSition 100000 // milliseconds
// The current player position of file/section of the file is at 1 minute 40 seconds.

//*********************************************************************************
// Reset play-related settings
//*********************************************************************************
:TSGen:CONFigure:SEEK:RESet

//*********************************************************************************
// Pause, stop, play the file.
//*********************************************************************************
:TSGen:CONFigure:COMMand PAUS
// Pauses playing the file.
:TSGen:CONFigure:COMMand STOP
// Stops playing the file.
:TSGen:CONFigure:COMMand PLAY
// Activates playing the file.

Example: Configure and monitor TS player output
//*********************************************************************************
// Configure general and stuffing parameters of the TS player output.
//*********************************************************************************
:TSGen:CONFigure:STUFfing ON
:TSGen:CONFigure:STOPdata TTSP
:TSGen:CONFigure:TSPacket H184
//:TSGen:CONFigure:PIDTestpacket VAR
:TSGen:CONFigure:PIDTestpack VAR
:TSGen:CONFigure:PID 8100
// Corresponds to a PID = 1FA4 in hexadecimal format.
:TSGen:CONFigure:PAYLoad PRBS
:TSGen:CONFigure:PRBS:SEQuence P23_1

//*********************************************************************************
// Monitor TS player output data.
//*********************************************************************************
:TSGen:CONFigure:COMMand STOP
// TSRate can only be changed if player is in stop mode
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:TSGen:CONFigure:TSRate 350E6 // net data rate = 350 MBit/s
:TSGen:CONFigure:COMMand PLAY

:TSGen:CONFigure:PLENgth?
// Response: P188 // packet length = 188 byte
:TSGen:READ:ORIGtsrate?
// Response: 5018502 bit/s

Example: Configure seamless loop parameters
:TSGen:CONFigure:SEAMless:CC ON
:TSGen:CONFigure:SEAMless:PCR OFF
:TSGen:CONFigure:SEAMless:TT ON
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:TSGen:CONFigure:COMMand<ch>

Triggers playing, pausing and stopping of the TS player file selected with :TSGen:
CONFigure:PLAYfile.

Setting parameters: 
<PlayerStatus> STOP | PLAY | PAUSe

*RST: STOP

Example: See Example "Play a TS player file" on page 117.

Usage: Event

Manual operation: See "Play" on page 61
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:TSGen:CONFigure:PAYLoad <PayLoad>

Determines the payload of the test packet. Also influences the payload of the gener-
ated stuffing packets while the TS player is running.

Parameters:
<PayLoad> HFF | H00 | PRBS

*RST: PRBS

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "Payload Test/Stuff" on page 65

:TSGen:CONFigure:PID <PID>

The available values depend on the settings of :TSGen:CONFigure:PIDTestpack.

If :TSGen:CONFigure:PIDTestpack is set to NULL,
then :TSGen:CONFigure:PID is 1FFF(hex).

Otherwise the values are variable.

Parameters:
<PID> integer

Range: 0  to  8191
*RST: 8191

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "PID (Hex)" on page 65

:TSGen:CONFigure:PIDTestpack <PIDTestpack>

Sets the PID, if :TSGen:CONFigure:TSPacket is H184|H200|H204.

Parameters:
<PIDTestpack> VARiable | NULL

*RST: NULL

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "PID Test Packet" on page 65

:TSGen:CONFigure:PLAYfile <PlayFile>

Specifies the file path and filename of the TS player file.

Parameters:
<PlayFile> string

Example: See Example "Play a TS player file" on page 117.
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Manual operation: See "Select File" on page 60

:TSGen:CONFigure:PLENgth <PLength>

Queries the packet length of the loaded file.

Parameters:
<PLength> P188 | P204 | P208 | INV

*RST: INV

Example: See Example "Configure and monitor TS player output"
on page 118.

:TSGen:CONFigure:PRBS[:SEQuence] <PRBS>

Sets the length of the PRBS sequence.

Parameters:
<PRBS> P15_1 | P23_1

*RST: P23_1

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "PRBS" on page 65

:TSGen:CONFigure:SEAMless:CC <CC>

Activates the correction of the continuity counters in the replayed TS data stream. The
correction allows you to decode the stream without interruption when the play file is
looping.

Parameters:
<CC> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Configure seamless loop parameters"
on page 119.

Manual operation: See "Continuity Counter" on page 66

:TSGen:CONFigure:SEAMless:PCR <PCR>

Activates the correction of time stamps in the replayed TS data stream. The correction
allows you to decode the stream without interruption when the play file is looping.

Parameters:
<PCR> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Configure seamless loop parameters"
on page 119.
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Manual operation: See "PCR, DTS/PTS" on page 66

:TSGen:CONFigure:SEAMless:TT <TT>

Activates the correction of the time and date table in the replayed TS data stream. The
correction allows you to decode the stream without interruption when the play file is
looping.

Parameters:
<TT> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Configure seamless loop parameters"
on page 119.

Manual operation: See "TDT/TOT" on page 66

:TSGen:CONFigure:SEEK:POSition <Position>

Sets the position, that is the current playing time position.

You can select a value in a 10-hour range.

Parameters:
<Position> float

Range: 0  to  36000000
Increment: 0.1
*RST: 0

Example: See Example "Play a TS player file" on page 117.

Manual operation: See "Running/Position Player [hh:mm:ss:fff]" on page 60

:TSGen:CONFigure:SEEK:RESet

Resets the following parametets to their default state:
● :TSGen:CONFigure:SEEK:STARt on page 122
● :TSGen:CONFigure:SEEK:STOP on page 123

Example: See Example "Play a TS player file" on page 117.

Manual operation: See "Reset Window" on page 61

:TSGen:CONFigure:SEEK:STARt <Start>

Sets an individual start time.

You can select a value in a 10-hour range.
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Parameters:
<Start> float

Range: 0  to  36000000
Increment: 0.1
*RST: 0

Example: See Example "Play a TS player file" on page 117.

Manual operation: See "Start [hh:mm:ss.fff]" on page 61

:TSGen:CONFigure:SEEK:STOP <Stop>

Sets an individual stop time.

You can select a value in a 10-hour range.

Parameters:
<Stop> float

Range: 0  to  36000000
Increment: 0.1
*RST: 23040.2

Example: See Example "Play a TS player file" on page 117.

Manual operation: See "Stop [hh:mm:ss.fff]" on page 61

:TSGen:CONFigure:STOPdata <StopData>

Ensures that a standardized TS data stream is always output at the TS output at the
rear of the R&S SMCV100B.

Parameters:
<StopData> TTSP | NONE

*RST: NONE

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "Stop Data" on page 63

:TSGen:CONFigure:STUFfing <Stuffing>

Enables or disables nullpacket stuffing.

Parameters:
<Stuffing> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "Nullpacket Stuffing" on page 63
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:TSGen:CONFigure:TSPacket <TSPaket>

Sets the structure of the generated test packets in pause or stop status.

Parameters:
<TSPaket> H184 | H200 | H204 | S187 | S203 | S207

S187|S203|S207
A sync byte (0x47) followed by 187/203/207 payload bytes.
H184|H200|H204
A sync byte (0x47) followed by three header bytes and
184/200/204 payload bytes.
*RST: H184

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "Packet Length" on page 63

:TSGen:CONFigure:TSRate <TSRate>

Sets the output data rate of the player.

Parameters:
<TSRate> integer

Range: 1  to  35E7
*RST: 5018502

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "Data Rate" on page 62

:TSGen:READ:FMEMory <FMemory>

Queries the file size of the TS player file.

Parameters:
<FMemory> integer

Range: 0  to  10
*RST: 0

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "Select File" on page 60

:TSGen:READ:ORIGtsrate <ORIGtsrate>

Displays the calculated original TS data rate.
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Parameters:
<ORIGtsrate> integer

Range: 1  to  350000000
*RST: 5018502

Example: See Example "Configure and monitor TS player output"
on page 118.

Manual operation: See "Orig. Data Rate" on page 63

:TSGen:READ:PLAYfile:LENGth?

Queries calculated original loop time.

Return values: 
<Length> integer

Range: 0  to  100
*RST: 0

Example: See Example "Configure and monitor TS player output"
on page 118.

Usage: Query only

Manual operation: See "Select File" on page 60
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Annex
A  ATSC 3.0 Test Cases

Test case type Test case Remark

P1S1 ATSC30_VV_xyz 33 test cases, xyz = 001 to 033

P1S2 ATSC30_VV_xyz 28 test cases, xyz = 034 to 061

P1S3 ATSC30_VV_xyz 4 test cases, xyz = 062 to 065

P1S4 ATSC30_VV_xyz 4 test cases, xyz = 066 to 069

P1S5 ATSC30_VV_xyz 68 test cases, xyz = 100 to 167

P1S6 ATSC30_VV_xyz 12 test cases, xyz = 170 to 181

P1S7 ATSC30_VV_xyz 3 test cases, xyz = 190 to 192

P1S8 ATSC30_VV_xyz 4 test cases, xyz = 196 to 199

P2S1 ATSC30_VV_xyz 24 test cases, xyz = 200 to 223

P2S2 ATSC30_VV_xyz 21 test cases, xyz = 224 to 244

P2S3 ATSC30_VV_xyz 36 test cases, xyz = 245 to 280

P6S1 ATSC30_VV_xyz 4 test cases, xyz = 600,603,604,605



Glossary: AbbreviationsR&S®SMCVB-K162

127User Manual 1179.0980.02 ─ 03

Glossary: Abbreviations
A

ALP: ATSC 3.0 Link Layer Protocol

ATSC: Advanced Television System Committee
https://www.atsc.org/

B
BCH: Bose Chaudhuri Hocquenghem coding

BICM: Bit-Interleaved Coding and Modulation

C
CRC: Cyclic Redundancy Check

D
DASH: Dynamic Adaptive Streaming over HTTP

F
FEC: Forward Error Correction

FFT: Fast Fourier Transform

FIFO: First In First Out

L
LDM: Layered Division Multiplexing

LDPC: Low-Density Parity Check

LMT: Link Mapping Table

M
MFN: Multiple frequency Network

MIMO: Multiple Input Multiple Output

MISO: Multiple Input Single Output

MMT: MPEG Media Transport

MPEG: Moving Picture Experts Group
https://mpeg.chiariglione.org/

 

https://www.atsc.org/
https://mpeg.chiariglione.org/
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O
OFDM: Orthogonal Frequency-Division Multiplexing

P
PHY: Physical Layer

PID: Packet Identifier

PLP: Physical Layer Pipe

PRBS: Pseudo-Random Bit Sequence as specified by ITU-T O.151

Q
QAM: Quadrature Amplitude Modulation

QPSK: Quaternary Phase Shift Keying

R
ROUTE: Real-time Object delivery over Unidirectional Transport

S
SFN: Single frequency Network

SISO: Single Input Single Output

SMPTE: Society of Motion Picture and Television Engineers
https://www.smpte.org/

STL: Studio Transmitter Link

T
TS: Transport Stream

https://www.smpte.org/
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Glossary: Specifications
A

ATSC 3.0: Advanced Television System Committee Standard 3.0
https://www.atsc.org/standards/atsc-3-0-standards/

ATSC A/322: ATSC Standard: Physical Layer Protocol (A/322)
E.g., version A/322-2016: https://www.atsc.org/atsc-30-standard/a3222016-physical-
layer-protocol/

ATSC A/324-2018: ATSC Standard: Scheduler / Studio to Transmitter Link
https://www.atsc.org/wp-content/uploads/2018/01/A324-2018-Scheduler-STL-2.pdf

ATSC A/330-2019: ATSC Standard: Link-Layer Protocol (A/330)
https://www.atsc.org/wp-content/uploads/2016/10/A330-2019a-Link-Layer-Protocol.pdf

I
ITU-T O.151: ITU-T Recommendation O.151
https://www.itu.int/rec/T-REC-O.151-199210-I/en

 

https://www.atsc.org/standards/atsc-3-0-standards/
https://www.atsc.org/atsc-30-standard/a3222016-physical-layer-protocol/
https://www.atsc.org/atsc-30-standard/a3222016-physical-layer-protocol/
https://www.atsc.org/wp-content/uploads/2018/01/A324-2018-Scheduler-STL-2.pdf
https://www.atsc.org/wp-content/uploads/2016/10/A330-2019a-Link-Layer-Protocol.pdf
https://www.itu.int/rec/T-REC-O.151-199210-I/en
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